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Utiliser LibreOffice sur un Mac

Sur Mac, certaines touches et certains éléments de menu sont différents de ceux utilisés sous
Windows ou Linux. Le tableau ci-dessous donne quelques substitutions courantes pour les instruc-
tions de ce chapitre. Pour une liste plus détaillée, voyez l’Aide de l’application.

Windows ou Linux Équivalent Mac Effet

Sélection du menu 
Outils > Options

LibreOffice > Préférences Accès aux options de configuration

Clic droit Control+clic ou clic 
droit selon la configuration 
de l’ordinateur

Ouvre un menu contextuel

Ctrl (Control) ⌘ (Command) Utilisé avec d’autres touches

F5 Shift+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles et Formatage

La documentation française de LibreOffice est disponible à
https://wiki.documentfoundation.org/Documentation/Publications/fr
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Qu’est-ce que Calc ?

Calc est le module tableur de LibreOffice. Vous pouvez saisir des données (ordinairement numé-
riques) dans un classeur puis les manipuler pour produire certains résultats.

Vous pouvez aussi saisir les données puis utiliser Calc dans un mode « Et si ? » en modifiant cer-
taines de ces données pour observer le résultat sans avoir à retaper la feuille ou le classeur en
entier.

Parmi les autres fonctionnalités de Calc, on trouve :

• Des fonctions qui peuvent servir à créer des formules pour effectuer des calculs complexes
sur les données.

• Des fonctions de base de données pour trier, stocker et filtrer les données.
• Des graphiques dynamiques : une large gamme de diagrammes en 2D et 3D.
• Des macros pour enregistrer  et  exécuter les tâches répétitives ;  parmi les langages de

script supportés, on trouve LibreOffice Basic, Python, BeanShell et JavaScript.
• La capacité à ouvrir, modifier et enregistrer les classeurs de Microsoft Excel.
• L’importation  et  l’exportation  de  classeurs  dans  de  nombreux  formats,  parmi  lesquels

HTML, CSV, PDF et PostScript.

Remarque
Si vous désirez utiliser dans LibreOffice des macros écrites dans Microsoft Excel avec
le code de macro VBA, vous devez d’abord éditer le code dans l’EDI de LibreOffice
Basic. Voyez le Chapitre 13,  Débuter avec les Macros et le Guide Calc, Chapitre 12,
Les macros de Calc.

Classeurs, feuilles de calcul et cellules

Calc travaille avec des éléments appelés classeurs. Un classeur est constitué de plusieurs feuilles
de calcul individuelles, contenant chacune des cellules disposées en lignes et en colonnes. Une
cellule donnée est identifiée par son numéro de ligne et la lettre de sa colonne.

Les cellules contiennent les éléments particuliers – textes, nombres, formules, etc. – qui consti-
tuent les données à afficher et à manipuler.

Chaque classeur peut posséder plusieurs feuilles de calcul et chaque feuille peut posséder plu-
sieurs cellules individuelles. Dans Calc, chaque feuille de calcul peut avoir au maximum 1 048 576
lignes (65 536 dans Calc 3.2 et précédents) et 1 024 colonnes. LibreOffice Calc peut gérer jusqu’à
32 000 feuilles.

La fenêtre principale de Calc

Quand Calc démarre, la fenêtre principale s’ouvre (Figure 1). Les éléments de cette fenêtre sont
décrits ci-dessous.

Remarque
Si une partie de la fenêtre de Calc (Figure 1) n’apparaît pas, vous pouvez l’afficher en
utilisant le menu Affichage. Par exemple, Affichage > Barre d’état va basculer (affi-
cher  ou masquer)  la  barre  d’état.  Il  n’est  pas  toujours  nécessaire  de tout  afficher,
comme sur la Figure 1; affichez ou masquez ce que vous voulez.
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Figure 1 : La fenêtre principale de Calc

La barre de titre
La barre de Titre, située tout en haut, afficher le nom du classeur ouvert. Quand il vient d’être créé,
à partir d’un modèle ou d’un document vide, son nom est Sans nom X, où X est un nombre. Quand
vous enregistrez le classeur pour la première fois, vous êtes invité à lui donner le nom de votre
choix.

La barre de Menu
La barre de Menu est l’endroit où vous sélectionnez un des menus et divers sous-menus appa-
raissent pour vous donner plus de choix.  Vous pouvez aussi personnaliser la barre de Menu :
voyez le Chapitre 14, Personnaliser LibreOffice pour plus d’informations.

• Fichier – contient les commandes qui s’appliquent à la totalité du document ; par exemple
Ouvrir, Enregistrer, Assistants, Exporter au format PDF, Imprimer, Signatures numériques.

• Édition –  contient  les  commandes  pour  l’édition  du  document ;  par  exemple  Annuler,
Copier, Suivi des modifications, Plug-in, etc.

• Affichage – contient les commandes pour modifier l’apparence de l’interface utilisateur de
Calc ; par exemple Barres d’outils, En-tête de colonnes/lignes, Plein écran, Zoom, etc.

• Insertion –  contient  les commandes pour insérer des éléments dans un classeur ;  par
exemple Image, Cadre, Diagramme, Fonctions, Caractères spéciaux, etc.

• Format – contient les commandes pour modifier l’agencement d’un classeur ; par exemple
Cellules, Page, Aligner, Formatage conditionnel, etc.
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• Feuille – contient les commandes pour modifier les éléments de la feuille ; par exemple
Insérer et  Supprimer des cellules, des colonnes, des lignes et  des feuilles ainsi que  des
Commentaires et Remplir les cellules, etc.

• Données – contient les commandes pour manipuler les données dans votre classeur ; par
exemple Définir la plage, Trier, Statistiques, Table de Pilote, Consolider, etc.

• Outils – contient diverses fonctions pour vous aider à vérifier et à personnaliser votre clas-
seur, par exemple Orthographe, Partager le classeur, Protéger la feuille, Macros, etc.

• Fenêtre – contient les commandes pour l’affichage de la fenêtre ; par exemple  Nouvelle
fenêtre, Fermer la fenêtre.

• Aide – contient des liens vers le système d’aide qui accompagne le logiciel et d’autres
fonctions diverses ; par exemple  Aide de LibreOffice,  Information de licence,  Vérifier les
mises à jour, etc.

Barres d’outils
Dans la disposition par défaut, à l’ouverture de Calc, les barres d’outils  Standard et  Formatage
sont ancrées en haut de l’espace de travail (Figure 1).

Les barres d’outils de Calc peuvent être soit ancrées à une position fixe, soit flottantes ce qui vous
permet de les déplacer à une position plus pratique sur votre espace de travail. Les barres d’outils
ancrées peuvent être libérées et soit déplacées à une position d’ancrage différente sur l’espace de
travail, soit laissées flottantes. Les barres d’outils qui sont flottantes quand on les ouvre peuvent
être ancrées à une position fixe sur votre espace de travail.

L’ensemble par défaut des icônes (parfois appelées boutons) des barres d’outils offre une grande
variété de commandes et de fonctions courantes. Vous pouvez aussi ajouter ou supprimer des
icônes des barres d’outils, voyez le  Chapitre 14, Personnaliser LibreOffice pour plus d’informa-
tions.

Placer le pointeur de la souris sur chacune de ces icônes fait apparaître une petite boîte, appelée
info-bulle. Elle donne une brève explication de la fonction de l’icône. Pour une explication plus
détaillée, choisissez Aide > Qu’est-ce que c’est ? et placez le pointeur de la souris sur l’icône.
Pour  désactiver  cette fonction,  cliquez dessus ou appuyez sur  la  touche  Échap.  Les  astuces
détaillées  (info-ballons)  peuvent  être  activées  ou  désactivées  depuis  Outils  >  Options  >
LibreOffice > Général.

La barre de formule
La barre de formule est située en haut de la feuille de calcul dans l’espace de travail de Calc. Elle
est ancrée de façon permanente à cette position et elle ne peut pas être rendue flottante. Si elle
n’est pas visible, allez à Affichage dans la barre de Menu et choisissez Barre de formule.

Figure 2 : La barre de formule

De gauche à droite sur la Figure 2, la barre de formule est constituée des éléments suivants :

• La Boîte de nom – indique la référence de la cellule actuellement active par une combinai-
son d’une lettre et d’un nombre, par exemple A1. La lettre indique la colonne et le nombre
la ligne de la cellule sélectionnée. Si vous avez sélectionné une plage de cellules qui a reçu
un nom, celui-ci est affiché dans cette boîte. Vous pouvez aussi taper une référence de cel-
lule dans la Boîte de nom pour sauter à la cellule référencée. Si vous tapez le nom d’une
plage nommée et que vous appuyez sur la touche Entrée, la plage nommée est sélection-
née et affichée.

• l’Assistant Fonctions  – ouvre une boîte de dialogue où vous pouvez parcourir une
liste des fonctions disponibles. Cette boîte peut être très utile, car il indique aussi les para-
mètres de ces fonctions.
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• Somme  – en cliquant sur l’icône Somme, on calcule le total des nombres dans les cel-
lules au-dessus de la cellule active et on place le résultat dans celle-ci. S’il n’y a pas de
nombres au-dessus de la cellule active, la somme est effectuée sur celles de gauche.

• Fonction  – cliquer sur l’icône Fonction insère un signe égal (=) dans la cellule active et
dans la ligne de saisie, ce qui permet de saisir la formule.

• La ligne de saisie – affiche le contenu de la cellule active (donnée, formule ou fonction) et
vous permet de modifier son contenu. Pour transformer la ligne de saisie en un zone de
saisie multi-ligne pour les très longues formules, cliquez sur le bouton de droite.

• Vous pouvez aussi éditer le contenu d’une cellule directement dans celle-ci en faisant un
double  clic  sur  la  cellule  elle-même.  Quand vous  saisissez  une  nouvelle  donnée,  Les

icônes Somme et Fonction sont remplacées par les icônes Annuler et Accepter .

Le contenu de la cellule courante (donnée, formule ou fonction) est affiché dans la Ligne de sai-
sie, qui est le reste de la barre de formule. Vous pouvez modifier le contenu de la cellule courante
soit ici, soit dans la cellule courante. Pour modifier dans la zone Ligne de saisie, cliquez dans la
zone, puis tapez vos modifications. Pour modifier dans la cellule courante, double-cliquez simple-
ment dans la cellule.

Remarque
Dans un classeur, le terme « fonction » va bien au-delà des simples fonctions mathé-
matiques. Voyez le Guide Calc, Chapitre 7, Utiliser les Formules et les Fonctions pour
plus d’informations.

Agencement d’un classeur

Cellules individuelles
La partie principale de l’espace de travail de Calc affiche des cellules disposées en grille. Chacune
est placée à l’intersection d’une colonne et d’une ligne.

Au sommet des colonnes et à gauche des lignes, il y a une série d’en-têtes qui contiennent des
lettres et  des nombres.  Les en-têtes de colonnes utilisent  un caractère alphabétique qui com-
mence à A et continue vers la droite. Les en-têtes de lignes utilisent un caractère numérique qui
débute à 1 et augmente vers le bas.

Ces en-têtes de colonnes et de lignes forment les références des cellules qui apparaissent dans la
Zone de nom de la barre de Formule (Figure 2). Si les en-têtes ne sont pas visibles dans votre
classeur, allez à Affichage dans la barre de Menu et cliquez sur En-têtes de colonnes/lignes.

Onglets de feuille de calcul
Dans Calc, vous pouvez avoir plusieurs feuilles de calcul dans un classeur. En bas de la grille de
cellule, vous trouverez des onglets qui indiquent le nombre de feuilles que votre classeur contient.
Cliquer sur un onglet donne accès à une feuille particulière et l’affiche. Un feuille active est indi-
quée par un onglet blanc (dans la disposition par défaut de Calc). Vous pouvez aussi sélectionner
plusieurs feuilles en appuyant sur la touche Ctrl pendant que vous cliquez sur les onglets (Voir
« Sélectionner des feuilles », page 25).

Pour modifier le nom par défaut d’une feuille (Feuille 1, Feuille 2, etc.), faites un clic droit sur l’on-
glet de la feuille et sélectionnez Renommer la feuille dans le menu contextuel. Une boîte de dia-
logue s’ouvre où vous pouvez taper un nouveau nom pour la feuille. Cliquez sur OK quand vous
avez fini pour refermer la boîte de dialogue.

Pour modifier la couleur de l’onglet, faites un clic droit sur celui-ci et sélectionnez Couleur d’on-
glet dans le menu contextuel pour ouvrir la boîte de dialogue Couleur d’onglet (Figure 3). Choisis-
sez votre couleur et cliquez sur OK quand vous avez fini pour refermer la boîte de dialogue. Pour

12 | Débuter avec Calc



ajouter de nouvelles couleurs à la palette, voyez le  Chapitre 14, Personnaliser LibreOffice pour
plus d’informations.

Figure 3 : La boîte de dialogue Couleur d'onglet

La barre d’état
La  barre d’état de Calc (Figure 4) offre des informations sur le classeur ainsi que des moyens
rapides et pratiques pour modifier certaines de ses propriétés. La plupart des champs sont sem-
blables à ceux des autres éléments de LibreOffice : voyez le Chapitre 1, Introduction à LibreOffice
de ce guide et le Guide Calc, Chapitre 1, Introduction à Calc pour plus d’informations.

Figure 4 : La barre d'état de Calc

Le volet latéral
Le volet latéral de Calc (Affichage > Volet latéral) (Figure 5) est situé à droite de la fenêtre. C’est
un mélange de barre d’outils et de boîte de dialogue qui est constitué de cinq plateaux : Proprié-
tés, Styles et formatage, Gallery, Navigateur et Fonctions. Chacun correspond à une icône sur
le panneau d’onglets à droite du volet latéral qui vous permet de passer de l’un à l’autre.
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Figure 5 : Volet latéral de Calc avec le plateau Propriétés ouvert

Les plateaux sont décrits ci-dessous.

• Propriétés : ce plateau contient cinq panneaux.

– Styles : permet le choix du style de la cellule, son actualisation et la création de nou-
veaux styles.

– Caractères :  fournit  les  contrôles  pour  formater  le  texte,  par  exemple  la  famille  de
police, la taille et la couleur. Certains contrôles, comme Exposant, ne sont actifs que si
le curseur de texte est actif dans la Ligne de saisie de la barre de Formule ou dans la
cellule.

– Alignement : fournit les contrôles pour aligner le texte de diverses manières, y compris
horizontalement et verticalement, le retour à la ligne, l’indentation, la fusion de cellules,
l’orientation du texte et l’empilement vertical.

– Apparence de cellule : offre des contrôles pour définir les options d’apparence, y com-
pris la couleur d’arrière-plan et le format des bordures (couleur et style de lignes, grille)
de la cellule.

– Format numérique : permet de modifier rapidement le format des nombres (nombre de
décimales, monnaie, dates ou texte numérique). Les contrôles des champs numériques
et étiquettes pour les fiches sont aussi disponibles.

Chaque panneau possède un bouton  Plus d’options qui  ouvre une boîte de dialogue
offrant un plus grand nombre d’options.  Ces boîtes de dialogue empêchent  l’édition du
document jusqu’à leur fermeture.

• Styles et formatage : ce plateau ne contient qu’un panneau qui est identique à celui qui
s’ouvre grâce au bouton  Styles et formatage (F11) de la barre d’outils  Formatage du
texte.

• Gallery : ce plateau ne contient qu’un panneau qui est identique à celui qui s’ouvre en cli-
quant sur le bouton Gallery dans la barre d’outils Standard ou Affichage > Galerie Clip
Art dans la barre de Menu.
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• Navigateur : ce plateau ne contient qu’un panneau qui est pratiquement le même que la
fenêtre Navigateur qui s’ouvre en cliquant sur le bouton Navigateur dans la barre d’outils
Standard ou en choisissant Affichage > Navigateur (F5) dans la barre de Menu. La seule
différence est que le bouton Contenu est absent du panneau du Volet latéral.

• Fonctions :  ce plateau ne contient  qu’un panneau qui  est  le même que la fenêtre qui
s’ouvre par Insertion > Fonction dans la barre de Menu.

À droite de la barre de titre de chaque plateau ouvert un bouton Fermer le volet latéral (X) permet
de clore le plateau en ne laissant que la barre d’Onglets ouverte. Cliquer sur n’importe quel onglet
ouvre de nouveau le plateau.

Le Volet latéral peut être masqué ou affiché, s’il est déjà masqué, en cliquant sur le bouton Affi-
cher/Masquer de la bordure. Vous pouvez ajuster la largeur du plateau en tirant sur la bordure
gauche du volet latéral.

Ouvrir des fichiers CSV

Les fichiers Comma-Separated-Values (CSV) sont des fichiers texte qui peuvent être lus, affichés
et modifiés dans une seule feuille de calcul. Chaque ligne d’un fichier CSV représente une ligne
d’une feuille de calcul. Les virgules, les points-virgules ou d’autres caractères sont utilisés pour
séparer les cellules. Le texte peut être saisi entre des guillemets ; les nombres sont saisis sans
guillemets.

Conseil
La plupart des fichiers CSV proviennent de tables, requêtes et rapports de bases de
données  où  des  calculs  et  diagrammes  supplémentaires  sont  nécessaires.  Sous
Microsoft Windows, les fichiers CSV ont souvent l’extension .xls pour ressembler à des
fichiers Excel mais leur structure interne reste celle des fichiers CSV.

Pour ouvrir un fichier CSV dans Calc :

 1) Choisissez Fichier > Ouvrir dans la barre de menu et recherchez le fichier CSV que vous
voulez ouvrir.

 2) Sélectionnez le fichier et cliquez sur  Ouvrir.  Par défaut un fichier CSV a l’extension .csv
mais certains ont pour extension .txt.

 3) Dans la boîte de dialogue Import de texte (Figure 6), sélectionnez les diverses options dis-
ponibles pour importer un fichier CSV dans un classeur de Calc.

 4) Cliquez sur OK pour ouvrir le fichier.

Les diverses options pour l’importation des fichiers CSV dans une feuille de calcul de Calc sont les
suivantes :

• Importer

– Jeu de caractères – définit le jeu de caractères à utiliser pour importer le fichier.
– Langue – Détermine comment les chaînes de nombres sont importées.

Si la langue est  définie comme  Par Défaut pour  l’importation CVS, Calc utilisera la
langue définie globalement. Si elle est définie comme langue spécifique, celle-ci sera
utilisée pour importer les nombres.

– À partir de la ligne – précise la ligne où vous désirez commencer l’importation. Les
lignes sont visibles dans la fenêtre d’aperçu au bas de la boîte de dialogue.
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Figure 6 : Boîte de dialogue Import de texte, avec le point-virgule et la tabulation 
comme séparateurs de colonne et le guillemet comme séparateur de texte

• Options de séparateur – précise si vos données utilisent des séparateurs ou des largeurs
fixes comme délimiteurs.

– Largeur fixe – sépare des données de largeur fixée (nombre égal de caractères) en
colonnes. Cliquez sur la règle dans la fenêtre d’aperçu pour définir la largeur.

– Séparée par – Choisissez le séparateur utilisé dans vos données pour les délimiter.
Quand vous choisissez Autre, vous précisez le caractère utilisé pour séparer vos don-
nées en colonnes. Le séparateur personnalisé doit aussi être contenu dans vos don-
nées.

– Fusionner  les  séparateurs –  combine  des  délimiteurs  consécutifs  et  supprime  les
champs de données vides.

– Séparateur de texte – sélectionnez un caractère pour délimiter les données textuelles.

• Autres options

– Champ entre guillemets comme texte – quand cette option est activée, les champs et
cellules dont  les  valeurs sont  entièrement  entre guillemets (le  premier  et  le  dernier
caractères de la valeur sont égaux au délimiteur de texte) sont importés comme textes.

– Détecter les nombres spéciaux – quand cette option est activée, Calc va automatique-
ment détecter tous les formats de nombres, y compris les formats spéciaux tels que les
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dates, les heures et la notation scientifique. La langue sélectionnée influence aussi la
manière dont ces nombres spéciaux sont reconnus puisque des langues et des régions
différentes peuvent avoir des conventions différentes pour de tels nombres.
Quand cette option est désactivée, Calc ne va détecter et convertir que les nombres
décimaux.  Le reste,  y  compris  les nombre formatés en notation scientifique,  seront
importés sous forme de texte. Une chaîne représentant un nombre décimal peut possé-
der des chiffres de 0 à 9, des séparateurs de milliers et un séparateur décimal. Les
séparateurs des milliers et décimal peuvent changer selon la langue et la région sélec-
tionnées.

• Champs – montre l’aspect de vos données séparées en colonnes.

– Type de colonne – sélectionnez une colonne dans la fenêtre d’aperçu et le type de don-
nées à appliquer aux données importées.

– Standard – Calc détermine le type de données.
– Texte – les données importées sont traitées comme du texte.
– Date(JMA)/Date(MJA)/Date(AMJ) –  les données importées sont  traitées comme des

dates avec le format indiqué.
– Anglais US – les nombres formatés en anglais US sont recherchés et inclus indépen-

damment de la langue du système. Aucun format de nombre n’est appliqué. S’il n’y a
pas d’entrées en anglais US, le format Standard est appliqué.

– Masquer – les données de la colonne ne sont pas importées.

La méthode ci-dessus fonctionne également avec les fichiers TXT.

Attention
La méthode d’ouverture des fichiers CSV est propre au module Calc. Si vous ouvrez
un fichier *.csv ou *.txt avec un autre module de LibreOffice (Writer par exemple), le
comportement sera différent.

Enregistrer les classeurs

Pour enregistrer un classeur, voyez le  Chapitre 1, Introduction à LibreOffice pour plus de détails
sur la façon d’enregistrer manuellement ou automatiquement. Calc permet aussi d’enregistrer les
classeurs dans toute une gamme de formats et aussi de les exporter dans les formats de fichiers
PDF, HTML et XHTML ; voyez le Guide de Calc, Chapitre 6, Imprimer, Exporter et Envoyer par
courrier électronique pour plus d’informations.

Les classeurs peuvent être enregistrés de trois manières :

• Appuyez sur Ctrl+S.
• Choisissez Fichier > Enregistrer (ou Tout enregistrer ou Enregistrer sous).
• Cliquez sur le bouton Enregistrer de la barre d’outils Standard.

Si le classeur n’a pas encore été sauvegardé précédemment, chacune de ces actions ouvrira la
boîte de dialogue Enregistrer sous. Vous pourrez alors spécifier le nom du classeur et l’emplace-
ment du stockage.

Remarque
Si le classeur a été enregistré précédemment, alors l’enregistrer en utilisant la com-
mande  Enregistrer (ou  Tout enregistrer) va écraser la version existante. Toutefois,
vous pouvez enregistrer le classeur à un emplacement différent ou avec un nom diffé-
rent en sélectionnant Fichier > Enregistrer sous.

Enregistrer les classeurs | 17



Enregistrer sous d’autres formats de classeurs
Si vous devez échanger des fichiers avec des utilisateurs qui ne peuvent pas recevoir des fichiers
dans le Format Open Document (ODF) (*.ods), que Calc utilise par défaut, vous pouvez enregis-
trer un classeur dans un autre format.

 1) Important – Enregistrez tout d’abord votre classeur dans le format de fichier ODF utilisé
par LibreOffice, *.ods. Si vous ne le faites pas, toutes les modifications que vous aurez pu
effectuer depuis le moment de votre dernier enregistrement apparaîtront uniquement dans
la version Microsoft Excel du document.

 2) Puis choisissez Fichier > Enregistrer sous. Dans la barre de menu pour ouvrir la boîte de
dialogue Enregistrer sous (Figure 7)

Figure 7 : Enregistrer un classeur au format Microsoft Excel

 3) Dans Nom de Fichier, vous pouvez saisir un nouveau nom pour votre classeur.
 4) Dans le menu déroulant Type de fichier, sélectionnez le type de format que vous désirez

utiliser.
 5) Si Extension automatique du nom de fichier est cochée, l’extension correcte pour le for-

mat que vous avez sélectionné sera ajoutée au nom du fichier.
 6) Cliquez sur Enregistrer.
 7) Chaque fois que vous cliquez sur Enregistrer, la boîte de dialogue Confirmer le format de

fichier (Figure 8) s’ouvre. Cliquez sur Utiliser le format XXX … pour terminer l’enregistre-
ment dans le format que vous avez choisi ou cliquez sur Utiliser le format ODF pour enre-
gistrer le classeur dans le format .ods de Calc.
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Figure 8 : Message de confirmation lors de l’enregistrement dans un format autre qu’ODF

Si vous choisissez le format Texte CSV (*.csv) pour votre classeur, la boîte de dialogue Export de
fichiers texte (Figure 9) s’ouvre.  Vous pouvez y choisir  le  jeu de caractères,  le  séparateur de
champ, le séparateur de texte, etc. à utiliser pour le fichier CSV.

Figure 9 : Choix des options lors de l’export en Texte CSV

Attention
À partir de ce moment, toutes les modifications que vous apporterez au classeur
auront lieu uniquement dans le document au nouveau format. Vous avez changé
le nom et le type de fichier de votre document. Si vous voulez revenir en arrière pour
travailler avec la version *.ods de votre classeur, vous devez l’ouvrir à nouveau.

Conseil
Pour que Calc enregistre par défaut les documents dans un format autre que ODF,
allez à Outils > Options > Chargement/Enregistrement, dans Format de fichier par
défaut et paramétrage ODF, sélectionnez Classeur dans Type de document et votre
format favori dans Enregistrer systématiquement sous.
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Naviguer dans les classeurs

Calc propose de nombreuses façons de naviguer à l’intérieur d’un classeur, de cellule à cellule et
de feuille à feuille. Vous pouvez en général utiliser la méthode que vous préférez.

Aller vers une cellule particulière
Quand une cellule est sélectionnée ou activée, ses bordures sont plus épaisses. Quand un groupe
de cellule est sélectionné, l’espace des cellules est coloré. La couleur de la bordure de la cellule
activée et celle du groupe sélectionné dépendent du système d’exploitation utilisé et de la façon
dont vous avez configuré LibreOffice.

• Utiliser la souris – Placez le pointeur de la souris sur la cellule et cliquez avec le bouton
gauche de la souris. Pour activer autre cellule avec la souris, déplacez simplement le poin-
teur de la souris sur la cellule que vous voulez activer et faites un clic avec le bouton
gauche.

• Utiliser une référence de cellule – Sélectionnez ou effacez la référence de cellule qui se
trouve dans la  Boîte de nom de la Barre de Formule (Figure 1, page  10). Tapez la réfé-
rence de la cellule où vous voulez aller et appuyez sur Entrée. Les références de cellules
peuvent être saisies en majuscules ou en minuscules : a3 ou A3, par exemple, sont iden-
tiques.

• Utiliser le Navigateur – Cliquez sur le bouton Navigateur  de la barre d’outils Stan-

dard (ou appuyez sur F5) pour afficher le Navigateur, ou cliquez sur l’onglet du Navigateur
dans le volet latéral. Tapez la référence de cellule dans les deux champs du haut, intitulés
Colonne et Ligne, et appuyez sur Entrée. Dans la Figure 10, le Navigateur sélectionnera
la cellule A1. Pour plus d’informations sur l’utilisation du Navigateur, le chapitre 1, Introduc-
tion à Calc, du Guide Calc.

Figure 10 : Le Navigateur de Calc
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• Utiliser les touches Tab et Entrée

– Appuyer sur  Entrée ou  Maj+Entrée active respectivement la cellule au-dessous et
au-dessus de la cellule actuellement active dans la même colonne.

– Appuyer sur Tab ou Maj+Tab active respectivement la cellule à droite et à gauche de
la cellule actuellement active sur la même ligne.

• Utiliser les touches flèches – Appuyer sur les touches flèches du clavier déplace le focus
dans la direction des flèches.

• Utiliser Début, Fin, Page précédente et Page suivante

– Début ( )↖  déplace le focus au début d’une ligne.
– Fin déplace le focus vers la colonne la plus à droite qui contient une donnée.
– Page suivante (PgSuiv) déplace l’affichage d’un écran complet vers le bas 
– Page précédente (PgPrec) déplace l’affichage d’un écran complet vers le haut.

Se déplacer de feuille en feuille
Chaque feuille dans un classeur est indépendante des autres, bien qu’elles puissent être liées par
des références d’une feuille à l’autre. Il y a trois façons de naviguer entre les différentes feuilles
d’un classeur.

• Avec le navigateur – Dans le navigateur (Figure 10, page 20), cliquez sur le symbole + à
côté de  Feuilles pour voir la liste des feuilles du classeur. Double-cliquez sur la feuille à
atteindre.

• Avec le clavier – Appuyez sur  Ctrl+Page suivante pour vous déplacer d’une feuille
vers la droite et appuyez sur  Ctrl+Page précédente pour vous déplacer d’une feuille
vers la gauche.

• Utiliser la souris – Cliquer sur un des onglets en bas du classeur permet de sélectionner
la feuille correspondante.

Si votre classeur contient beaucoup de feuilles, certains des onglets peuvent alors être cachés
derrière la barre de défilement horizontal en bas de l’écran. Si c’est le cas :

• Les quatre boutons à la gauche des onglets peuvent alors faire apparaître les onglets 
cachés. La Figure 11 montre comment le faire.

Figure 11 : Flèches d'onglet des feuilles

• Tirer la bordure de la barre de défilement peut faire apparaître l’onglet désiré.

• Un clic droit sur un des boutons ouvre un menu contextuel où vous pouvez sélectionner 
une feuille (voir Figure 12).

Naviguer dans les classeurs | 21



Figure 12 : Un clic droit sur un des cinq boutons

Remarques
Notez  que  les  feuilles  ne  sont  pas  numérotées  dans  l’ordre.  La  numérotation  des
feuilles est arbitraire. La barre d’état de la Figure 12 indique que Feuille6 est en qua-
trième position parmi les sept feuilles du classeur. Il est recommandé de renommer les
feuilles pour les reconnaître plus facilement.

Navigation au clavier
Pour parcourir un classeur avec le clavier, en appuyant sur une touche ou une combinaison de
touches. Dans ce cas, appuyez sur plusieurs touches à la fois. Le  Tableau 1 donne la liste des
touches et combinaisons de touches que vous pouvez utiliser pour parcourir  un classeur dans
Calc.

Tableau 1 : Se déplacer de cellule à cellule en utilisant le clavier

Combinaison de 
touches

Mouvement

→ Une cellule sur la droite

← Une cellule sur la gauche

↑ Une cellule vers le haut

↓ Une cellule vers le bas

Ctrl+→ Vers la première colonne sur la droite contenant une donnée sur cette ligne
si la cellule active est vide.
Vers la dernière cellule sur la droite dans la même plage de cellules 
occupées sur cette ligne si la cellule active contient des données.
Vers la dernière colonne à droite dans la feuille de calcul s’il n’y a plus de 
cellules à droite contenant des données.

Ctrl+← Vers la dernière colonne sur la gauche contenant une donnée sur cette 
ligne si la cellule active est vide.
Vers la première cellule sur la gauche dans la même plage de cellules 
occupées sur cette ligne si la cellule active contient des données.
Vers la première colonne dans la feuille de calcul s’il n’y a plus de cellules à
gauche contenant des données.
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Combinaison de 
touches

Mouvement

Ctrl+↑ Vers la première cellule vers le haut contenant une donnée dans cette 
colonne si la cellule active est vide.
Vers la première ligne de la même plage de cellules occupées si la cellule 
active contient des données.
Vers la première ligne de la feuille de calcul s’il n’y a plus de cellule au-
dessus contenant des données.

Ctrl+↓ Vers la première cellule vers le bas contenant une donnée dans cette 
colonne si la cellule active est vide.
Vers la dernière ligne de la même plage de cellules occupées si la cellule 
active contient des données.
Vers la dernière ligne de la feuille de calcul s’il n’y a plus de cellule au-
dessus contenant des données.

Ctrl+↖ Vers la cellule A1

Ctrl+Fin Vers le coin inférieur droit de la zone rectangulaire qui contient des 
données dans la même feuille

Alt+PgSuiv Un écran sur la droite (si possible)

Alt+PgPrec Un écran sur la gauche (si possible)

Ctrl+PgSuiv Vers la même cellule dans la feuille sur la droite (dans les onglets)

Ctrl+PgPrec Vers la même cellule dans la feuille sur la gauche (dans les onglets)

Tab Vers la prochaine cellule sur la droite

Maj+Tab Vers la prochaine cellule sur la gauche

Entrée Une cellule vers le bas (sauf changement par l’utilisateur)

Maj+Entrée Une cellule vers le haut (sauf changement par l’utilisateur)

Conseil
Utilisez Alt+→ ou Alt+← pour augmenter ou diminuer la largeur d’une cellule.

Personnaliser la touche Entrée
Vous pouvez personnaliser la direction dans laquelle la touche Entrée déplace l’activation de la
cellule en allant dans Outils > Options > LibreOffice Calc > Général. Sélectionnez la direction
du mouvement dans la liste déroulante. Selon le fichier utilisé ou le type de données saisies, une
direction différente peut être utile. La touche  Entrée peut aussi être utilisée pour passer en et
hors mode d’édition. Utilisez les deux premières options sous Paramètres de saisie (Figure 13)
pour changer le paramétrage de la touche Entrée.

Figure 13 : Personnaliser la touche Entrée
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Sélectionner des éléments dans une feuille ou un classeur

Sélectionner des cellules

Cellule individuelle
Faites un clic gauche dans la cellule. Vous pouvez vérifier votre sélection en regardant dans la
Boîte de nom de la barre de Formule (Figure 1 page 10).

Plage de cellules contiguës
Vous pouvez sélectionner une plage de cellules en utilisant le clavier ou la souris.

Pour sélectionner une plage de cellules en faisant glisser la souris :

 1) Cliquez dans une cellule.
 2) Appuyez et gardez appuyé le bouton gauche de la souris.
 3) Déplacez la souris sur l’écran.
 4) Une fois que le bloc de cellules souhaité est en surbrillance, relâchez le bouton gauche de

la souris.

Pour sélectionner une plage de cellules sans faire glisser la souris :

 1) Cliquez dans la cellule qui sera un des coins de la plage de cellules.
 2) Déplacez la souris dans le coin opposé de la plage de cellules.
 3) Gardez appuyée la touche Maj et cliquez.

Conseil
Vous pouvez aussi sélectionner une plage de cellules contiguës en commençant par
cliquer sur le champ Mode de sélection de la barre d’État (Figure 4 page 13) et en
choisissant Sélection étendue avant de cliquer sur les coins opposés de la plage de
cellules. Assurez-vous de revenir à Sélection standard ou vous pourriez vous retrou-
vez en train d’étendre involontairement une sélection de cellule.

Pour sélectionner une plage de cellules sans utiliser la souris :

 1) Sélectionnez la cellule qui sera un des coins de la plage de cellules.
 2) En gardant appuyée la touche  Maj,  utilisez les flèches du curseur pour sélectionner le

reste de la plage.

Conseil
Vous pouvez également sélectionner directement une plage de cellules en utilisant la
Boîte de nom de la barre de Formule (Figure 1 page 10). Cliquez dans la Boîte de
nom comme décrit dans “Utiliser une référence de cellule” page 20. Pour sélection-
ner une plage de cellules, saisissez la référence de cellule du coin supérieur gauche,
suivi de deux points (:), et ensuite de la référence de cellule du coin inférieur droit. Par
exemple, pour sélectionner la plage qui va de A3 à C6, vous saisiriez A3:C6.

Plage de cellules non contiguës
 1) Sélectionnez la cellule ou la plage de cellules en utilisant une des méthodes ci-dessus.
 2) Déplacez le pointeur de la souris vers le début de la prochaine plage ou cellule individuelle.
 3) Maintenez appuyée la touche Ctrl et cliquez ou cliquez et faites glisser pour sélectionner

une autre plage de cellules à ajouter à la première plage.
 4) Répétez autant que nécessaire.
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Sélectionner des colonnes et les lignes

Colonne ou ligne individuelle
Pour sélectionner une colonne individuelle, cliquez sur la lettre identifiant la colonne (voir Figure 1
page 10) ou utilisez le raccourci-clavier Ctrl+Maj+Espace.

Pour sélectionner une ligne individuelle, cliquez sur le numéro identifiant la ligne ou utilisez le rac-
courci-clavier Maj+Espace.

Colonnes ou lignes multiples
Pour sélectionner des colonnes ou lignes multiples qui sont contiguës :

 1) Cliquez sur la première colonne ou ligne du groupe.
 2) Gardez appuyée la touche Maj.
 3) Cliquez sur la dernière colonne ou ligne du groupe.

Pour sélectionner des colonnes ou lignes multiples qui ne sont pas contiguës :

 1) Cliquez sur la première colonne ou ligne du groupe.
 2) Gardez appuyée la touche Ctrl.
 3) Cliquez sur toutes les colonnes ou lignes suivantes en gardant appuyée la touche Ctrl.

Feuille entière
Pour sélectionner la feuille entière, cliquez dans la petite boîte entre l’en-tête de colonne A et l’en-
tête de ligne 1 (Figure 14).  Vous pouvez également appuyer sur  Ctrl+A pour sélectionner la
feuille entière ou aller dans le menu Édition et sélectionner Tout sélectionner.

Figure 14 : Boîte Tout sélectionner

Sélectionner des feuilles
Vous pouvez sélectionner une ou plusieurs feuilles. Il peut être intéressant de sélectionner plu-
sieurs feuilles en même temps si vous voulez effectuer des modifications dans plusieurs feuilles en
une seule fois.

Feuille individuelle
Cliquez sur l’onglet de la feuille que vous voulez sélectionner. L’onglet de la feuille active devient
blanc dans le paramétrage par défaut de Calc (voir Figure 11 page 21).

Plusieurs feuilles contiguës
Pour sélectionner plusieurs feuilles contiguës :

 1) Cliquez sur l’onglet de la première feuille désirée.
 2) Déplacez le pointeur de la souris sur l’onglet de la dernière feuille désirée.
 3) Gardez appuyée la touche Maj et cliquez sur l’onglet.
 4) Tous  les  onglets  entre  ces  deux  feuilles  deviennent  blancs  (avec  le  paramétrage  par

défaut). Toute action que vous ferez affectera désormais toutes les feuilles en surbrillance.

Plusieurs feuilles non contiguës
Pour sélectionner plusieurs feuilles non contiguës :

 1) Cliquez sur l’onglet de la première feuille désirée.
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 2) Déplacez le pointeur de la souris sur l’onglet de la deuxième feuille désirée.
 3) Gardez appuyée la touche Ctrl et cliquez sur l’onglet.
 4) Répétez autant que nécessaire.
 5) Les onglets sélectionnés deviennent blancs (avec le paramétrage par défaut). Toute action

que vous ferez affectera désormais toutes les feuilles en surbrillance.

Toutes les feuilles
Faites un clic droit sur l’un des onglets et choisissez  Sélectionner toutes les feuilles dans le
menu contextuel.

Pour désélectionner
Pour revenir au fonctionnement par défaut avec une seule feuille sélectionnée, il suffit de cliquer
sur  l’onglet  d’une  feuille  non  sélectionnée.  Si  toutes  les  feuilles  sont  sélectionnées,  faites  un
Ctrl+clic sur un des onglets.

Remarque
Si une couleur d’onglet a été définie pour une feuille, lorsque cette feuille est sélection-
née, la couleur n’apparaît qu’en bas de l’onglet et le reste de la zone devient blanc.

Attention
Une fois les modifications effectuées sur les différentes feuilles, pensez à revenir à une
seule feuille sélectionnée, sinon vos modifications continueront à s’appliquer à toutes
les feuilles. Pour cela, cliquez sur l’onglet d’une feuille non sélectionnée.

Actions sur les colonnes et les lignes

Insérer des colonnes et des lignes

Remarque
Les cellules des nouvelles colonnes ou lignes sont formatées comme les cellules cor-
respondantes  de  la  colonne  ou  de  la  ligne  avant  (ou  à  gauche  de)  les  nouvelles
colonnes ou lignes insérées.

Colonne ou ligne individuelle
Utiliser le menu Feuille :

 1) Sélectionnez la cellule, colonne ou ligne où vous voulez insérer la nouvelle colonne ou
ligne.

 2) Allez  à  Feuille dans  la  barre  de  Menu  et  sélectionnez  soit  Insérer  des  colonnes  >
Colonnes de gauche ou Colonnes de droite soit  Insérer des lignes > Lignes au-des-
sus ou Lignes en dessous.

Utiliser la souris :

 1) Sélectionnez la colonne ou la ligne où vous voulez insérer la nouvelle colonne ou ligne.
 2) Faites un clic droit sur l’en-tête de colonne ou de ligne.
 3) Choisissez Insérer des colonnes à gauche, Insérer des colonnes à droite, Insérer des

lignes au-dessus ou Insérer des lignes au-dessous dans le menu contextuel.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent être insérées en une fois plutôt qu’une par une.
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 1) Mettez en surbrillance le nombre voulu de colonnes et de lignes en gardant appuyé le bou-
ton gauche de la souris sur la première et ensuite en le faisant glisser sur le nombre voulu
d’identifiants.

 2) Procédez comme pour insérer une seule colonne ou ligne ci-dessus.

Supprimer des colonnes et des lignes
Les colonnes et les lignes peuvent être supprimées individuellement ou par groupes.

Colonne ou ligne individuelle
Une colonne ou ligne individuelle peut être supprimée en utilisant la souris :

 1) Sélectionnez une cellule dans la colonne ou la ligne à supprimer.
 2) Choisissez Feuille > Supprimer des cellules depuis la barre de menus ou faites un clic

droit et choisissez Supprimer dans le menu contextuel.
 3) Cochez l’option dont vous avez besoin dans la boîte de dialogue  Supprimer des cellules

(Figure 15).

Figure 15 : La boîte de dialogue Supprimer des cellules

Vous pouvez aussi

 1) Cliquer sur l’en-tête de la colonne ou de la ligne pour la sélectionner.
 2) Aller à Feuille dans la barre de Menu et choisir Supprimer des colonnes ou Supprimer

des lignes ou faire un clic droit sur l’en-tête et choisir Supprimer les colonnes ou Suppri-
mer les lignes dans le menu contextuel.

Colonnes ou lignes multiples
Les colonnes ou lignes multiples peuvent être supprimées en une fois plutôt qu’une par une.

 1) Mettez en surbrillance le nombre voulu de colonnes ou de lignes (voir  « Colonnes ou
lignes multiples » page 25 pour plus d’information).

 2) Procédez comme pour supprimer une seule colonne ou ligne comme ci-dessus.

Conseil
Au lieu de supprimer une ligne ou une colonne, vous pouvez souhaiter supprimer les
contenus des cellules, mais garder la ligne ou la colonne vide. Voir le chapitre 2 du
guide Calc (Saisir, modifier et formater les données) pour instructions.

Actions sur les feuilles

Insérer de nouvelles feuilles
Il y a plusieurs façons d’insérer une nouvelle feuille. La méthode la plus rapide est de cliquer sur le

bouton Ajouter une feuille  (voir Figure 11). Elle insère une nouvelle feuille après la dernière,

sans ouvrir la boîte de dialogue  Insérer une feuille. Les méthodes suivantes ouvrent la boîte de
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dialogue  Insérer une feuille (Figure 16) où vous pouvez insérer plus d’une feuille, renommer la
feuille, insérer la feuille ailleurs dans la séquence ou choisir une feuille dans un fichier.

Sélectionnez les feuilles près desquelles la nouvelle feuille va être insérée. Puis utilisez l’une des
options suivantes.

• Choisissez Feuille > Insérer une feuille depuis la barre de menus.
• Faites un clic droit sur l’onglet ou dans l’espace vide après les onglets et choisissez Insérer

une feuille dans le menu contextuel.
• Cliquez sur un espace vide à la fin de la ligne des onglets.

Figure 16 : La boîte de dialogue Insérer une feuille

Conseil
Vous pouvez fixer  le nombre de feuilles des nouveaux documents en sélectionnant
Outils > Options > LibreOffice Calc > Par défaut. Par défaut, une seule feuille de
calcul est créée lors de la création d’un nouveau document.

Déplacer et copier des feuilles
Vous pouvez déplacer ou copier des feuilles dans le même classeur par glisser/déposer ou en utili-
sant la boîte de dialogue  Déplacer/copier la feuille. Pour déplacer ou copier une feuille dans un
autre classeur, vous devez utiliser cette boîte de dialogue.

Par glisser et déposer
Pour déplacer une feuille à une position différente dans le même classeur, cliquez et maintenez le
bouton appuyé sur l’onglet de la feuille et tirez-le à sa nouvelle position avant de relâcher le bou-
ton.

Pour  copier une feuille dans le même classeur, maintenez la touche  Ctrl appuyée (la touche
Option sur Mac) puis cliquez sur l’onglet de la feuille et tirez-le à sa nouvelle position avant de
relâcher le bouton de la souris. Le pointeur de la souris peut changer et comporter un signe plus
selon la configuration de votre système d’exploitation.
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Figure 17 : Faire glisser une feuille pour la déplacer

En utilisant une boîte de dialogue
Utilisez la boîte de dialogue Déplacer/copier la feuille (Figure 18) pour spécifier exactement si vous
voulez déplacer ou copier la feuille dans le même classeur ou dans un autre, indiquer sa position
dans le classeur et son nom.

Figure 18 : La boîte de dialogue Déplacer/copier la feuille

 1) Dans le document en cours, faites un clic droit sur l’onglet de la feuille que vous désirez
déplacer ou copier puis sélectionnez Déplacer/copier la feuille dans le menu contextuel
ou allez à Feuille > Déplacer/copier la feuille dans la barre de Menu.

 2) Dans la section Action, cochez Déplacer pour déplacer la feuille ou Copier pour la copier.
 3) Choisissez le classeur où vous désirez placer la feuille dans la liste déroulante  Vers le

document. Cela peut être le même classeur, un autre classeur déjà ouvert ou un nouveau
classeur.

 4) Définissez dans Insérer avant la position où vous voulez placer la feuille.
 5) Tapez un nom dans la boîte de texte Nouveau nom si vous voulez renommer la feuille en

la déplaçant ou en la copiant. Si vous ne précisez pas de nom, Calc en crée un par défaut
(Feuille 2, Feuille 3, etc.).

 6) Cliquez sur OK pour confirmer l’opération et fermer la boîte de dialogue.
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Attention
Si vous choisissez comme document de destination un autre classeur ouvert ou - nou-
veau  document  -,  cela  peut  créer  des  conflits  pour  les  formules  liées  à  d’autres
feuilles  du document  d’origine.  Si  vous déplacez involontairement  une feuille,  vous
pouvez y remédier en déplaçant ou copiant la feuille à son emplacement d’origine.

Supprimer des feuilles

Feuille individuelle
Faites un clic droit sur l’onglet que vous voulez supprimer et choisissez Supprimer la feuille dans
le menu contextuel, ou choisissez  Feuille > Supprimer des feuilles dans la barre de menus.
Dans tous les cas, un avertissement vous demandera si vous voulez supprimer la feuille définitive-
ment. Cliquez sur Oui.

Feuilles multiples
Pour supprimer des feuilles multiples, sélectionnez-les comme décrit auparavant (page 25), puis
faites un clic droit sur l’un des onglets et choisissez Supprimer la feuille dans le menu contextuel,
ou choisissez  Feuille > Supprimer des feuilles dans la barre de menus. Cliquez sur  Oui pour
confirmer la suppression.

Renommer des feuilles
Le nom par défaut d’une nouvelle feuille est  aaaX,  où  aaa est le préfixe défini dans  Outils >
Options > LibreOffice Calc > Par défaut (Feuille par défaut) et X est un numéro. Si cela convient
pour un petit classeur avec seulement quelques feuilles, cela devient moins lisible lorsqu’il y en a
beaucoup.

Pour donner à une feuille un nom plus significatif, vous pouvez :

• saisir le nom dans la Zone de nom (Figure 16 page 28) quand vous créez la feuille avec la
boîte de dialogue Insérer une feuille ;

• faire un clic droit sur l’onglet et choisir Renommer la feuille dans le menu contextuel ; rem-
placer le nom existant par un nouveau.

• faire Alt+Clic sur l’onglet pour y modifier directement le nom ;
• faire un double clic sur l’onglet pour ouvrir la boîte de dialogue Renommer la feuille.

Remarque
Les noms de feuilles doivent commencer soit par une lettre, soit par un chiffre ; les
autres caractères, y compris les espaces, sont interdits. Après le premier caractère, les
caractères autorisés sont les lettres, les chiffres, les espaces et le caractère souligné
(_) Tenter de donner un nom incorrect à une feuille produit un message d’erreur.

Affichage de Calc

Modifier l’affichage du document
Utilisez la fonction zoom pour afficher plus ou moins de cellules dans la fenêtre pendant que vous
travaillez sur un classeur. Pour plus de renseignement sur le zoom, voyez le Chapitre 1, Présenta-
tion de LibreOffice dans ce guide.
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Figer les lignes et les colonnes
Le fait de figer verrouille un certain nombre de lignes en haut d’un classeur et un certain nombre
de colonnes à sa gauche ou les deux à la fois.  Quand vous vous déplacez ensuite dans une
feuille, les cellules des lignes et colonnes figées restent toujours visibles.

La  Figure 19 montre quelques lignes et colonnes figées. Le trait horizontal plus épais entre les
lignes 4 et 14 ainsi que le trait vertical entre les colonnes B et G indiquent que les lignes 1 à 4 et
les colonnes A et B sont figées. Les lignes de 5 à 13 et les colonnes de C à F ont été décalées
hors de l’affichage.

Figure 19 : Lignes et colonnes figées

Comment figer des lignes ou des colonnes
 1) Vous pouvez cliquer sur

– l’en-tête de la ligne sous celles que vous voulez figer,
– l’en-tête de la colonne à droite de celles que vous voulez figer.

 2) Sélectionnez Affichage > Fixer lignes et colonnes dans la barre de Menu ou cliquez sur

l’icône  Fixer lignes et  colonnes  dans la  barre d’outils  Standard.  Une ligne plus

épaisse apparaît entre les lignes ou les colonnes figées et libres.

Vous pouvez aussi :

 1) Cliquer  sur  la  cellule  immédiatement  sous  les  lignes  et  immédiatement  à  droite  des
colonnes que vous voulez figer.

 2) Sélectionner Affichage > Fixer lignes et colonnes dans la barre de Menu ou cliquer sur

l’icône  Fixer lignes et colonnes  dans la  barre d’outils  Standard.  Une ligne plus

épaisse apparaît entre les lignes et les colonnes figées et libres.

Comment libérer les lignes et les colonnes figées
Pour libérer les lignes ou les colonnes, allez à Affichage > Fixer lignes et colonnes dans la barre

de Menu ou cliquez sur l’icône Fixer lignes et colonnes  dans la barre d’outils Standard. Les

traits plus épais qui marquent les lignes et colonnes figées disparaîtront.

Scinder l’écran
Une autre façon de changer l’affichage est de scinder la fenêtre. L’écran peut être scindé horizon-
talement, verticalement, ou les deux. Vous pouvez par conséquent avoir jusqu’à quatre portions de
la feuille à l’affichage en même temps comme sur la Figure 20.

Pourquoi scinder la fenêtre ? Un exemple serait un grand classeur dans lequel une des cellules
contient un nombre qui est utilisé par trois formules dans d’autres cellules. En scindant l’écran,
vous pouvez positionner la cellule contenant le nombre dans une section et chacune des cellules
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avec formule dans les autres sections. Vous pouvez alors changer le nombre dans la cellule et voir
comment cela affecte les résultats de chacune des formules.

Figure 20 : Exemple d'écran scindé

Comment scinder l’écran horizontalement ou verticalement
 1) Vous pouvez cliquer sur

– l’en-tête de la ligne sous celles où vous voulez scinder l’écran horizontalement,
– l’en-tête de la colonne à droite de celles où vous voulez scinder l’écran verticalement.

 2) Allez à  Affichage > Scinder la fenêtre dans la barre de Menu. Une ligne plus épaisse
apparaît entre les lignes et les colonnes qui délimitent le partage (voir Figure 20).

Vous pouvez aussi (voir Figure 21)

• Tirer la nouvelle bordure de fenêtre horizontale sous la ligne où vous voulez placer le par-
tage horizontal.

• Tirer la nouvelle bordure de fenêtre verticale à droite de la colonne où vous voulez placer le
partage vertical.

Figure 21 : Partage interactif de la fenêtre

Comment scinder l’écran horizontalement et verticalement
 1) la cellule immédiatement sous les lignes et immédiatement à droite des colonnes où vous

voulez scinder l’écran.
 2) Allez à  Affichage > Scinder la fenêtre dans la barre de Menu. Une ligne plus épaisse

apparaît entre les lignes et les colonnes qui délimitent le partage (voir Figure 20).

Comment supprimer le partage de l’écran
Pour annuler un partage de l’écran,

• replacez les bordures de fenêtres scindées à leur position aux extrémités des barres de
défilement (Figure 21)

• allez à Affichage > Scinder la fenêtre dans la barre de Menu pour décocher l’option.
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Saisir des données en utilisant le clavier

La plupart des saisies de données dans Calc peuvent être faites en utilisant le clavier.

Saisir des nombres
Cliquez dans la cellule et tapez le nombre en utilisant les touches numériques soit de la partie prin-
cipale du clavier, soit du pavé numérique. Par défaut, les nombres sont alignés à droite.

Nombres négatifs
Pour entrer un nombre négatif, tapez le signe moins (–) devant celui-ci ou placez-le entre paren-
thèses, par exemple (1234).

Le signe plus (+) n’est pas nécessaire pour les nombres positifs.

Zéros non significatifs
Pour conserver un nombre minimum de chiffres dans une cellule quand on saisit des nombres
dans le but de conserver le format numérique, par exemple 1234 et 0012, des zéros non significa-
tifs doivent être ajoutés à l’aide d’une des méthodes suivantes :

Méthode 1

 1) La cellule étant sélectionnée, ouvrez la boîte de dialogue Formatage des cellules (Figure
22) par l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez  Formater les cellules dans le menu
contextuel,

– allez à Format > Cellules dans la barre de Menu,
– utilisez le raccourci Ctrl+1 au clavier.

Figure 22: La boîte de dialogue Formatage des cellules – la page Nombres

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Nombre dans la liste Caté-
gorie.
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 3) Dans  Options > Zéros non significatifs,  saisissez le  nombre minimum de caractères
nécessaires. Par exemple, pour quatre caractères, tapez 4. Tout nombre ayant moins de
quatre caractères sera précédé de zéros non significatifs, par exemple 12 deviendra 0012.

 4) Cliquez sur OK. Le nombre saisit conserve son format numérique et toute formule utilisée
dans le classeur traitera l’entrée comme un nombre dans les fonctions des formules.

Méthode 2

 1) Sélectionnez la cellule.
 2) Ouvrez le Volet latéral (Affichage > Volet latéral) et cliquez sur l’icône (+) d’ouverture du

panneau Format numérique pour ouvrir celui-ci.
 3) Choisissez Nombre dans la liste déroulante Catégorie.
 4) Tapez 4 dans la boîte Zéros non significatifs. Le format est immédiatement appliqué.

Figure 23: Définir le nombre de zéros non significatifs

Si un nombre est saisi avec des zéros non significatifs, par exemple 01481, sans que le paramé-
trage des zéros non significatifs ait été fait, par défaut Calc va automatiquement les supprimer.
Pour les préserver :

 1) Tapez une apostrophe (‘) avant le nombre, par exemple ‘01481.
 2) Activez  une autre cellule.  L’apostrophe est  automatiquement  supprimée,  les  zéros  non

significatifs sont conservés et le nombre est converti en texte aligné à gauche.

Nombres sous forme de texte
Les nombres peuvent aussi être saisis sous forme de texte grâce à l’une des méthodes suivantes :

Méthode 1
 1) La cellule étant sélectionnée, ouvrez la boîte de dialogue Formatage des cellules (Figure

22) par l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez  Formater les cellules dans le menu
contextuel,

– allez à Format > Cellules dans la barre de Menu,
– utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Texte dans la liste Catégorie.
 3) Cliquez sur OK. Le nombre saisi est converti en texte et aligné par défaut à gauche.

Méthode 2
 1) Sélectionnez la cellule.
 2) Ouvrez le Volet latéral (Affichage > Volet latéral) et cliquez sur l’icône (+) d’ouverture du

panneau Format numérique pour ouvrir celui-ci.
 3) Choisissez  Texte dans la  liste  déroulante  Catégorie.  Le  formatage est  immédiatement

appliqué à la cellule.
 4) Cliquez sur la cellule. Saisissez le nombre et activez une autre cellule pour que la donnée

soit mise en forme.
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Remarque
Par  défaut,  tout  nombre  mis  en  forme  comme texte  dans  un  classeur  sera  traité
comme un zéro par tous les formules utilisées. Les fonctions ignorent les entrées tex-
tuelles dans les formules.

Saisir des textes
Cliquez dans la cellule et tapez le texte. Les textes sont alignés à gauche par défaut.

Pour saisir un texte de plusieurs lignes dans une cellule, vous pouvez insérer des retours à la ligne
en tapant Ctrl+Entrée.

Vous pouvez agrandir la zone de saisie en cliquant sur l’icône Étendre la barre Formule . La

zone de saisie devient alors multi-lignes (Figure 24). Cliquez à nouveau sur l’icône  pour revenir

à la zone de saisie initiale.

Figure 24 : Zone de saisie multi-ligne

Saisir des dates et des heures
Sélectionnez la cellule et tapez la date ou l’heure. 

Vous pouvez séparer les éléments de la date avec un slash (/) ou un tiret (–) ou utiliser un texte
comme 10 octobre 13. Calc reconnaît plusieurs formats de date ; le format utilisé par Calc s’appli-
quera automatiquement.

Vous pouvez séparer les éléments de l’heure avec des deux-points comme 10:43:45. Le format
horaire utilisé par Calc s’appliquera automatiquement.

Pour modifier le format de date ou d’heure utilisé par Calc, appliquez une des méthodes suivantes.

Méthode 1
 1) La cellule étant sélectionnée, ouvrez la boîte de dialogue Formatage des cellules (Figure

22) par l’une des méthodes suivantes :

– faites un clic droit sur la cellule et sélectionnez  Formater les cellules dans le menu
contextuel,

– allez à Format > Cellules dans la barre de Menu,
– utilisez le raccourci Ctrl+1 au clavier.

 2) Vérifiez que l’onglet Nombres est sélectionné puis choisissez Date ou Heure dans la liste
Catégorie.

 3) Choisissez le format que vous désirez utiliser dans la liste Format.
 4) Cliquez sur OK.

Méthode 2
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 1) Sélectionnez la cellule.
 2) Ouvrez le Volet latéral (Affichage > Volet latéral) et cliquez sur l’icône (+) d’ouverture du

panneau Format numérique pour ouvrir celui-ci.
 3) Choisissez Date ou Heure dans la liste déroulante Catégorie.
 4) Cliquez sur le bouton Plus d’options dans la barre de titre du panneau pour ouvrir la boîte

de dialogue Formatage des cellules (Figure 22).
 5) Choisissez le format que vous désirez utiliser dans la liste Format.
 6) Cliquez sur OK.

Figure 25 : Format Date

Les formats de saisie des dates reconnus par Calc peuvent être définis dans l’option Motifs d’ac-
ceptation de date dans Outils > Options > Paramètres linguistiques > Langues, avec les nota-
tions suivantes : D pour le jour, M pour le mois et Y pour l’année.

Conseil
Les raccourcis clavier  Ctrl+; et  Maj+Ctrl+; permettent d’entrer la date et l’heure
courante dans la cellule, respectivement formatées en date et en heure. L’entrée est
effectuée sous forme de valeur. Comme ce ne sont pas des fonctions ou des champs,
les données ne sont pas actualisées par la suite.

Options d’autocorrection
Calc applique automatiquement plusieurs changements durant la saisie de données, à moins que
vous n’ayez désactivé  cette fonction.  Vous pouvez également  annuler  immédiatement  chaque
changement automatique avec Ctrl+Z ou en revenant manuellement à la modification pour rem-
placer l’autocorrection par ce que vous désirez voir vraiment.

Pour modifier les options d’autocorrections, allez à  Outils > Options d’autocorrection dans la
barre de Menu pour ouvrir la boîte de dialogue AutoCorrection (Figure 26).

Remplacer
Éditez la table de remplacement pour la correction automatique ou le remplacement de mots ou
d’abréviations dans votre document.

Exceptions
Précisez les abréviations ou combinaisons de lettres que vous ne voulez pas que LibreOffice cor-
rige automatiquement.

Options
Sélectionnez les options pour la correction des erreurs en cours de frappe puis cliquez sur OK.

Options linguistiques
Spécifiez les options d’autocorrection des guillemets et d’autres options particulières à la langue
utilisée pour les textes.
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Figure 26 : La boîte de dialogue AutoCorrection

Réinitialiser
Rétablit les valeurs par défaut définies par LibreOffice.

Désactiver les modifications automatiques

Changements de l’AutoCorrection
Voir « Options d’autocorrection » ci-dessus.

AutoSaisie
Quand vous tapez du texte dans une cellule, Calc suggère automatiquement une occurrence trou-
vée dans la même colonne. Pour activer ou désactiver l’AutoSaisie, affichez ou enlevez une coche
devant Outils > AutoSaisie.

Conversion automatique des dates
Calc convertit automatiquement certaines saisies en dates. Pour s’assurer qu’une saisie qui res-
semble à une date est considérée comme un texte, formatez la cellule en texte ou tapez une apos-
trophe au début de la saisie.

Saisir des données en utilisant le clavier | 37



Accélérer la saisie des données

La saisie de données dans un classeur peut demander beaucoup de travail, mais Calc fournit plu-
sieurs outils pour en alléger certaines corvées.

La fonctionnalité la plus simple est de faire glisser et déposer le contenu d’une cellule dans une
autre avec la souris. Beaucoup de personnes trouvent également utile l’AutoSaisie. Calc recèle
également plusieurs autres outils pour la saisie automatique, plus particulièrement pour les tâches
répétitives. Ce sont l’outil Remplir, les listes de sélection et la possibilité de saisir de l’information
dans plusieurs feuilles du document.

Utiliser l’outil Remplir dans les cellules
L’outil Remplir de Calc permet de dupliquer le contenu existant ou de créer une suite dans une
suite de cellules de votre classeur (Figure 27).

 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.
 2) Tirez la souris dans n’importe quelle direction ou appuyez sur la touche Maj et cliquez sur

la dernière cellule que vous voulez remplir.
 3) Allez à Feuille > Remplir les cellules dans la barre de Menu et sélectionnez la direction

dans laquelle vous voulez copier ou créer les données (Vers le bas,  A gauche,  Vers le
haut, A gauche), Séries, ou Nombre aléatoire dans le sous-menu.

Figure 27 : Utiliser l’outil Remplir

Vous pouvez aussi utiliser un raccourci pour remplir les cellules.

 1) Sélectionnez la cellule qui contient ce que vous désirez copier ou l’amorce de la série.
 2) Déplacez le pointeur sur le petit carré en bas à droite de la cellule sélectionnée. Le pointeur

change de forme.
 3) Cliquez et tirez dans la direction où vous désirez remplir les cellules. Si la cellule initiale

contenait du texte, celui-ce sera automatiquement recopié. Si la cellule initiale contenait un
nombre (seul ou en fin de chaîne), une suite croissante sera créée si vous tirez vers la
droite ou vers le bas, décroissante si vous tirez vers la gauche ou vers le haut.

 4) Si la cellule initiale contient un nombre et que vous appuyez simultanément sur la touche
Ctrl, son contenu est recopié au lieu d’être incrémenté ou décrémenté.

Utiliser des séries de remplissage
Quand vous choisissez Feuille > Remplir les cellules > Série dans la barre de Menu, la boîte de
dialogue Remplir la série s’ouvre (Figure 28). Vous pouvez y sélectionner le type de série que vous
voulez.
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Figure 28 : La boîte de dialogue Remplir la série

• Direction – définit la direction dans laquelle la suite est créée.

– Bas – crée une suite du haut vers le bas de la zone de cellules sélectionnées en utili-
sant l’incrément défini jusqu’à la valeur finale.

– Droite – crée une suite de gauche à droite dans la zone de cellules sélectionnées en
utilisant l’incrément défini jusqu’à la valeur finale.

– Haut – crée une suite du bas vers le haut dans la zone de cellules sélectionnées en uti-
lisant l’incrément défini jusqu’à la valeur finale.

– Gauche – crée une suite de droite à gauche dans la zone de cellules sélectionnées en
utilisant l’incrément défini jusqu’à la valeur finale.

• Type de séries – définit le type de la suite.

– Arithmétique – crée une suite arithmétique en ajoutant l’incrément à la valeur précé-
dente jusqu’à la valeur finale définie.

– Géométrique – crée une suite géométrique en multipliant la valeur précédente par l’in-
crément jusqu’à la valeur finale définie.

– Date – crée une suite de dates en ajoutant l’incrément à la date précédente jusqu’à la
date finale définie, compte tenu de l’unité de temps définie.

– Remplir automatiquement – crée une suite directement dans la feuille. La fonction de
remplissage automatique prend en compte les listes personnalisées. Par exemple, si
vous saisissez janvier dans la première cellule, la suite est complétée à partir de la liste
définie dans Outils > Options > LibreOffice Calc > Listes de tri (Figure 29). Le rem-
plissage automatique essaie de déterminer les valeurs d’une suite en définissant un
incrément arithmétique. Par exemple, une suite numérique commençant par 1, 3, 5 est
automatiquement  complétée  par  7,  9,  11,  13 ;  une  suite  de  date  commençant  par
01/01/99 et 16/01/99 sera complétée par des dates espacées de quinze jours.

• Unité de temps – vous pouvez y spécifier l’unité de temps désirée. La zone n’est active
que si l’option Date a été cochée dans la zone Type de série.

– Jour – utilisez le type de série Date et cette option pour créer une suite utilisant sept
jours.

– Jour de la semaine – utilisez le type de série Date et cette option pour créer une suite
utilisant cinq jours ouvrables.

– Mois – utilisez le type de série Date et cette option pour créer une suite à partir des
noms ou des abréviations des mois.

– Année – utilisez le type de série Date et cette option pour créer une suite d’années.
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• Valeur finale – définit la valeur finale de la suite. Utilisez des nombres, des dates ou des
heures.

• Incrément – définit la valeur par laquelle les éléments de la suite du type sélectionné sont
modifiés à chaque étape. La valeur ne peut être saisie que si le type de série arithmétique,
géométrique ou date a été sélectionné.

Figure 29 : La boîte de dialogue Listes de tri

Définir une liste de remplissage
Pour définir vos propres listes de remplissage :

 1) Allez à  Outils > Options > LibreOffice Calc > Listes de tri pour ouvrir la boîte de dia-
logue  Listes de tri (Figure 29). Celui-ci affiche les suites définies précédemment dans la
boîte Listes à gauche et le contenu de la liste sélectionnée dans la boîte Entrées.

 2) Cliquez sur Nouveau et la boîte Entrées se vide.
 3) Tapez la suite de la nouvelle liste dans la boîte Entrées (une valeur par ligne).
 4) Cliquez sur Ajouter et la nouvelle liste apparaît désormais dans la zone Listes.
 5) Cliquez sur OK pour enregistrer la nouvelle liste.

Définir une liste de remplissage à partir d’une plage d’une feuille

Vous pouvez définir une liste de remplissage à partir d’une plage de valeurs textuelles.

 1) Sélectionnez la plage qui contient les valeurs de texte que vous désirez utiliser comme liste
de remplissage.

 2) Allez à  Outils > Options > LibreOffice Calc > Listes de tri pour ouvrir la boîte de dia-
logue Listes de tri (Figure 29).

 3) La plage sélectionnée se trouve dans la boîte Copier la liste depuis. Cliquez sur Copier
pour ajouter les valeurs aux listes de tri.
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Utiliser les listes de sélection
Les listes de sélection sont disponibles uniquement pour les textes et sont limitées à l’usage de
textes qui ont été déjà saisis dans la même colonne.

Pour utiliser une liste de sélection :

 1) Sélectionnez une cellule vide dans une colonne contenant déjà des entrées textuelles et
appuyez sur  Alt+↓ (flèche bas) ou faites un clic droit et choisissez  Liste de sélection.
Une liste déroulante apparaît, contenant toutes les cellules de la même colonne qui ont au
moins un caractère de texte ou dont le format est défini comme texte. Les textes des cel-
lules sont triés par ordre alphabétique et ceux qui ont des occurrences multiples n’appa-
raissent qu’une seule fois.

 2) Cliquez sur l’entrée dont vous avez besoin pour que le texte s’insère dans la cellule sélec-
tionnée.

Partager du contenu entre différentes feuilles

Vous pouvez vouloir entrer la même information dans la même cellule de plusieurs feuilles, par
exemple pour fixer des listes standard pour un groupe de personnes ou pour des organismes. Au
lieu de saisir la liste individuellement dans chaque feuille, vous pouvez la saisir en une fois pour
toutes les feuilles. Pour ce faire, 

 1) Allez à Feuille > Sélectionner des feuilles dans la barre de Menu pour ouvrir la boîte de
dialogue Sélectionner des feuilles.

Figure 30 : La boîte de dialogue Sélectionner des feuilles

 2) Sélectionnez les feuilles où vous désirez que l’information soit répétée. Utilisez les touches
Maj et Ctrl (Options sur Mac) pour sélectionner plusieurs feuilles.

 3) Cliquez sur OK pour sélectionner les feuilles dont les onglets changent de couleur.

 4) Saisissez l’information dans la feuille courante, elle sera répétée dans toutes les feuilles
sélectionnées.

Attention
Cette  technique  écrase  toute  information  qui  se  trouve déjà  dans  les  cellules  des
autres feuilles,  sans aucun avertissement.  Pour cette raison,  quand vous avez fini,
assurez-vous de bien désélectionner  toutes les feuilles sauf  celle  que vous voulez
modifier. (Ctrl+clic sur un onglet pour sélectionner ou désélectionner la feuille.)
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Valider le contenu des cellules

Quand vous créez des classeurs destinés à être utilisés par d’autres personnes, vous pouvez vou-
loir vous assurer qu’elles saisissent des données qui sont valides ou appropriées pour la cellule.
Vous pouvez également utiliser la validation pour votre propre usage comme guide pour saisir des
données complexes ou rarement utilisées.

Les séries de remplissage et les listes de sélection peuvent convenir pour certains types de don-
nées, mais elles sont limitées aux informations prédéfinies. Pour valider une nouvelle donnée sai-
sie par un utilisateur, sélectionnez une cellule et utilisez Données > Validité sur la barre de Menu
pour définir le type de contenu qui peut être saisi dans cette cellule. Par exemple, une cellule peut
nécessiter une date ou un nombre entier, sans caractère alphabétique ni point décimal ; ou bien
encore une cellule ne doit pas être laissée vide.

Selon le paramétrage de la validation, l’outil peut aussi définir l’intervalle des valeurs qui peuvent
être saisies, et fournir des messages d’aide qui expliquent les règles de validation que vous avez
paramétrées pour cette cellule (ce que les utilisateurs devraient faire s’ils saisissent un contenu
incorrect). Vous pouvez aussi paramétrer la cellule pour refuser un contenu incorrect, l’accepter
avec un avertissement, ou, si vous êtes très organisé, exécuter une macro si une erreur est saisie.

Pour plus d’informations sur cette fonctionnalité, voir le chapitre 2,  Saisir, éditer et formater des
données dans le Guide Calc.

Modifier les données

Supprimer les données d’une cellule

Supprimer seulement les données
Les données seules peuvent être supprimées dans une cellule sans affecter le formatage de la
cellule. Cliquez dans la cellule pour la sélectionner et appuyez ensuite sur la touche Suppr.

Supprimer les données et le formatage
Les données et le formatage peuvent être supprimés d’une cellule en une seule fois.

 1) Cliquez sur la cellule pour la sélectionner.
 2) Appuyez sur la touche Retour arrière (ou faites un clic droit et choisissez Effacer du

contenu, ou utilisez Feuille > Effacer des cellules) pour ouvrir la boîte de dialogue Sup-
primer du contenu (Figure 31). Dans cette boîte de dialogue, plusieurs attributs de la cellule
peuvent être supprimés. Pour tout supprimer dans une cellule (contenu et format), cochez
Tout supprimer.

Figure 31  : La boîte de dialogue Supprimer du contenu
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Remplacer toutes les données dans une cellule
Pour supprimer les données et insérer de nouvelles données, tapez simplement par-dessus les
anciennes données. Les nouvelles données conserveront le format des précédentes.

Vous pouvez aussi cliquer dans la Ligne de Saisie de la Barre de Formule (Figure 1 page 10), puis
faire un double clic sur les données pour les sélectionner totalement et taper les nouvelles don-
nées.

Modifier les données dans une cellule
Il est parfois nécessaire de changer le contenu d’une cellule sans en supprimer tout le contenu,
par exemple quand la phrase “Jean va partir” se trouve dans une cellule et doit être changée en
“Jean va partir demain.” Il est souvent utile de le faire sans tout d’abord supprimer l’ancien contenu
de la cellule.

Utiliser le clavier
 1) Sélectionnez la cellule désirée en cliquant à l’intérieur.
 2) Appuyez sur la touche F2 et le curseur sera placé à la fin de la cellule.
 3) Utilisez alors les flèches du clavier pour déplacer le curseur dans le texte de la cellule à la

position où débute la modification.
 4) Appuyez sur la touche  Entrée quand vous avez terminé pour enregistrer vos modifica-

tions.

Utiliser la souris
Vous pouvez soit

 1) Double-cliquez dans la cellule voulue (pour la sélectionner et placer le curseur à l’intérieur
pour modification).

 2) Cliquer dans la cellule pour placer le curseur à l’endroit où vous désirez commencer les
modifications et effectuer celles-ci.

Ou bien

 1) Cliquez pour sélectionner la cellule.
 2) Déplacez le pointeur de la souris dans la ligne de saisie (Figure 1 page 10) et cliquez à l’in-

térieur pour placer le curseur pour modification.

Quand vous avez terminé, cliquez hors de la cellule pour la désactiver et enregistrer vos modifica-
tions.

Formater les données

Remarque
Tous les paramétrages abordés dans cette section peuvent aussi être effectués en tant
qu’éléments d’un style de cellule. Voir le chapitre 4, Utiliser les styles et les modèles,
du Guide Calc pour plus d’informations.

Formater plusieurs lignes de texte
Des lignes de texte multiples peuvent être saisies dans une seule cellule en utilisant le renvoi à la
ligne automatique ou des retours manuels à la ligne. Chaque méthode est utile dans différentes
situations.

Utiliser le retour à la ligne automatique
Méthode 1
Pour que le texte revienne à la ligne en fin de cellule,
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 1) Ouvrez la boîte de dialogue Formatage des cellules par l’une des méthodes suivantes :

– faites un clic droit et sélectionnez Formater les cellules dans le menu contextuel
– choisissez Format > Cellules depuis la barre de menus, 
– appuyez sur Ctrl+1.

 2) Cliquez sur l’onglet Alignement (Figure 32),

Figure 32  : La boîte de dialogue Formatage des cellules, onglet Alignement

 3) Sous Propriétés, cochez Renvoi à la ligne automatique et cliquez sur OK. Le résultat est
montré ci-dessous (Figure 33).

Figure 33 : Retour à la ligne automatique

Méthode 2
 1) Sélectionnez la cellule.
 2) Ouvrez le Volet latéral (Affichage > Volet latéral) et cliquez sur l’icône (+) d’ouverture du

panneau Alignement pour ouvrir celui-ci.
 3) Cochez Ajuster le texte pour appliquer immédiatement le formatage.
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Figure 34 : Formatage du retour à la ligne.

Utiliser les sauts de ligne manuels
Pour  insérer  un  saut  de  ligne  manuel pendant  la  frappe  dans  une  cellule,  appuyez  sur
Ctrl+Entrée. Pour insérer un saut de ligne dans un texte déjà saisi, double-cliquez dans la cel-
lule à l’endroit où vous voulez faire un saut de ligne (il est aussi possible de cliquer dans la ligne de
saisie à l’endroit concerné) avant d’appuyer sur Ctrl+Entrée.

Quelle que soit la méthode (renvoi à la ligne automatique ou saut de ligne manuel), la hauteur de
ligne est adaptée mais la largeur de cellule ne change pas. La Figure 35 montre le résultat de la
saisie de deux sauts de ligne manuels après la  première ligne de texte.  Vous devez modifier
manuellement la largeur de la cellule ou repositionner votre saut de ligne pour que votre texte ne
déborde pas de la fin de la cellule.

Figure 35  : Cellule avec sauts de ligne manuels

Ajuster le texte à la taille de la cellule
La taille de police des données d’une cellule peut être automatiquement ajustée pour remplir la
cellule. Pour le faire, cochez l’option Ajuster à la taille de la cellule dans la boîte de dialogue For-
matage des cellules (Figure 32) à la page Alignement. La Figure 36 montre le résultat. Cette boîte
de dialogue est aussi accessible en cliquant sur le bouton Plus d’options dans la barre titre Ali-
gnement de l’onglet Propriétés du Volet Latéral.

Figure 36 : Ajustement de la taille de police à la cellule

Formater les nombres
Plusieurs formats de nombres différents peuvent être appliqués aux cellules en utilisant les icônes
de la barre d’outils Formatage (Figure 37). Sélectionnez la cellule, puis cliquez sur l’icône corres-
pondante. Certaines icônes peuvent ne pas être visibles avec le réglage par défaut ; faites un clic
droit sur la barre puis choisir Boutons visibles et sélectionnez les icônes à afficher.
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Figure 37  : Icônes de formats de nombres. De gauche à droite : monnaie, pourcentage, 
date, scientifique, nombre, standard, ajouter une décimale, supprimer une décimale.

Pour plus de contrôle ou pour sélectionner d’autres formats de nombres, utilisez l’onglet Nombres
(Figure 38) de la boîte de dialogue Formatage des cellules :

• Appliquez l’un des types de données de la liste Catégorie aux données.
• Contrôlez le nombre de décimales et de zéros non significatifs dans Options.
• Saisissez une description de format personnalisée.
• Le paramètre Langue détermine les paramètres locaux pour les différents formats comme

l’ordre dans les dates et le symbole de l’unité monétaire.

Figure 38  : La boîte de dialogue Formatage des cellules, onglet Nombres

Certains formats numériques sont accessibles depuis le panneau Formats numériques du Volet

Latéral dans l’onglet Propriétés (Figure 39). Cliquez sur le bouton Plus d’options  pour ouvrir

la boîte de dialogue Formatage des cellules décrit ci-dessus.

Figure 39 : Icônes de formats numériques dans le
panneau Format numérique du Volet latéral

Formater la police
Pour choisir rapidement la police utilisée dans une cellule :

 1) Sélectionnez la cellule
 2) Cliquez sur la flèche près du champ  Nom de police dans la  barre d’outils  Formatage

(Figure 40) et choisissez une police dans la liste.
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 3) Pour choisir la taille de la police, cliquez sur la flèche près du champ Taille de police dans
la barre d’outils Formatage et choisissez une taille dans la liste.

Figure 40 : Mise en forme du texte dans la barre d'outils Formatage

 4) Pour d’autres attributs, vous pouvez utiliser les icônes Gras, Italique ou Soulignage.
 5) Pour modifier l’alignement du paragraphe, cliquez sur une des quatre icônes d’alignement

(Gauche, Centré, Droite, Justifié).
 6) Pour choisir une couleur de police, cliquez sur la flèche près de l’icône Couleur de police

 pour afficher la palette des couleurs. Cliquez sur la couleur voulue.

Pour définir des couleurs personnalisées, utilisez  Outils > Options > LibreOffice > Couleurs.
Voir le chapitre 14 du Guide Calc pour plus d’informations.

L’onglet Propriétés du Volet latéral possède cinq panneaux, Styles, Caractère, Alignement, For-
mat Numérique et Apparence de la cellule qui contiennent tous les contrôles de mise en forme
de la barre d’outils Formatage.

Vous pouvez aussi utiliser le bouton Plus d’options  de l’un des panneaux du Volet latéral pour

ouvrir la boîte de dialogue Formatage des cellules.

Pour spécifier la langue de la cellule (utile pour permettre à plusieurs langues d’exister dans un
même document et d’être vérifiées correctement (orthographe)), utilisez l’onglet Police de la boîte
de dialogue Formatage des cellules.

Utilisez l’onglet  Effets de caractère de la boîte de dialogue Formatage des cellules pour définir
d’autres propriétés de la police. Voir le chapitre 4 du Guide Calc, Utiliser les Styles et les Modèles
dans Calc, pour plus d’informations.

Formater les bordures des cellules
Pour formater les bordures d’une cellule ou d’un groupe de cellules sélectionnées, cliquez sur

l’icône Bordures  de la barre d’outils Formatage et choisissez une des options proposées par

la palette.

Pour choisir rapidement un style de ligne et une couleur pour les bordures d’une cellule, cliquez

sur la petite flèche près des icônes Style de bordure  et Couleur de bordure  dans la

barre d’outils Formatage pour afficher une palette Style de bordure ou Couleur de bordure. Si ces
icônes ne sont pas affichées dans la barre d’outils Formatage, faites un clic droit sur la barre puis
choisissez Boutons visibles et sélectionnez les icônes à afficher. Dans chaque cas, une palette
de choix est affichée.

Le panneau Apparence de cellule dans l’onglet Propriétés du Volet latéral contient les contrôles
Bordure de cellule, Style de ligne et Couleur de ligne.

Pour plus de contrôle, comme l’espacement entre les bordures de la cellule et le texte, utilisez l’on-
glet Bordures de la boîte de dialogue Formatage des cellules. Là, vous pouvez également définir
un style d’ombre.

Formater les données | 47



Cliquer sur le bouton Plus d’options  de la barre de titre Apparence de cellule ou sur Plus

d’options dans la liste déroulante style de ligne de ce panneau, ouvre la boîte de dialogue Forma-
tage des cellules à la page Bordures où vous pouvez aussi définir un Style d’ombre.

Voir le chapitre 4 du Guide Calc, Utiliser les Styles et les Modèles dans Calc, pour plus de détails.

Remarque
Les propriétés de bordure de cellule s’appliquent à une cellule,  et ne peuvent être
modifiées que dans cette cellule. Par exemple, si la cellule C3 a une bordure haute (ce
qui est visuellement équivalent à une bordure basse dans C2), cette bordure ne pourra
être supprimée qu’en sélectionnant C3. Elle ne pourra pas être supprimée dans C2.

Formater l’arrière-plan des cellules
Pour choisir rapidement une couleur d’arrière-plan pour une cellule ou d’un groupe de cellules, cli-

quez sur la petite flèche près de l’icône Couleur d’arrière-plan dans la barre d’outils Forma-

tage. Une palette de choix de couleurs, identique à la palette Couleur de police, est affichée.

Vous pouvez également utiliser l’onglet  Arrière-plan de la boîte de dialogue Formatage des cel-
lules.

Le panneau Apparence de cellule dans l’onglet Propriétés du Volet latéral contient un contrôle
Arrière-plan de cellule avec une palette de couleurs.

Pour définir des couleurs personnalisées, utilisez  Outils > Options > LibreOffice > Couleurs.
Voir le chapitre 14 du Guide Calc pour plus d’informations.

Voir le chapitre 4 du Guide Calc, Utiliser les Styles et les Modèles dans Calc, pour plus de détails.

Formatage automatique des cellules

Utiliser l’AutoFormat
Vous pouvez utiliser la fonction AutoFormat de Calc pour mettre en forme rapidement et facilement
un groupe de cellules.

 1) Sélectionnez les cellules que vous voulez formater dans au moins trois colonnes et trois
lignes, y compris les en-têtes de colonnes et de lignes.

 2) Allez à Format > Styles d’AutoFormat dans la barre de Menu pour ouvrir la boîte de dia-
logue AutoFormat (Figure 41).

 3) Choisissez le type et la couleur de formatage dans la liste.
 4) Sélectionnez les propriétés de formatage à inclure dans la fonction AutoFormat.
 5) Cliquez sur OK.
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Figure 41 : La boîte de dialogue AutoFormat

Définir un nouvel AutoFormat
Vous pouvez définir un nouvel AutoFormat qui sera disponible pour tous les classeurs.

 1) Mettez en forme le type de données, la police, sa taille, les bordures et l’arrière-plan, etc.
d’un groupe de cellules.

 2) Allez à Édition > Tout sélectionner dans la barre de Menu pour sélectionner tout le clas-
seur.

 3) Allez à Format > Styles d’AutoFormat pour ouvrir la boîte de dialogue AutoFormat où le
bouton Ajouter est maintenant actif.

 4) Cliquez sur Ajouter.
 5) Dans la zone Nom de la boîte de dialogue Ajouter un AutoFormat qui s’ouvre alors, tapez

un nom significatif pour le nouveau format.
 6) Cliquez sur OK pour l’enregistrer. Le nouvel AutoFormat est maintenant disponible dans la

liste Format de la boîte de dialogue AutoFormat.

Utiliser les thèmes

Calc offre un ensemble prédéfini de thèmes de formatage que vous pouvez appliquer aux clas-
seurs. Il n’est pas possible d’ajouter de nouveaux thèmes à Calc ni de les modifier. Vous pouvez
toutefois changer leurs styles après les avoir appliqués à un classeur et ces styles modifiés ne
sont disponibles que pour celui-ci quand vous l’enregistrez.

Pour appliquer un thème à un classeur :

 1) Cliquez sur l’icône Sélectionner des thèmes  dans la barre d’outils Outils. Si celle-ci

n’est pas visible, allez à Affichage > Barres d’outils dans la barre de Menu et cliquez sur
Outils. La boîte de dialogue Sélection de thème s’ouvre (Figure 42). Il donne la liste des
thèmes applicables à l’ensemble du classeur.

 2) Choisissez le thème que vous désirez appliquer. Dès votre choix effectué, les styles du
thème sont appliqués au classeur et immédiatement visibles.
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 3) Cliquez sur OK.
 4) Si vous le souhaitez, vous pouvez alors ouvrir la fenêtre Styles et Formatage pour modifier

des styles particuliers. Ces modifications ne changent pas le thème : elles ne font  que
changer l’apparence du style dans le classeur précis que vous utilisez.

Figure 42 : La boîte de dialogue Sélection de thème

Utiliser le formatage conditionnel

Vous pouvez paramétrer le formatage des cellules pour qu’il change selon les conditions que vous
spécifiez. Par exemple, dans un tableau de nombres, vous pouvez afficher toutes les valeurs au-
dessus de la moyenne en vert et celles en dessous de la moyenne en rouge.

Remarque
Pour appliquer un formatage conditionnel,  Calculer automatiquement doit être activé.
Cochez Données > Calculer > Calculer automatiquement.

Voir le chapitre 2 Entrer, modifier et formater des données du Guide Calc pour plus d’informations
sur le formatage conditionnel.

Masquer et afficher les données

Quand des éléments sont masqués, ils ne sont ni visibles ni imprimables, mais ils peuvent toujours
être sélectionnés pour une copie si vous sélectionnez les éléments autour d’eux. Par exemple, si
la colonne B est masquée, elle est copiée si vous sélectionnez les colonnes A et C. Quand vous
avez à nouveau besoin d’un élément masqué, vous pouvez inverser le processus et afficher l’élé-
ment.

Pour plus d’informations sur comment masquer/afficher des données, en particulier pour utiliser les
outils  Plans et groupes, ou le filtrage de données, voir le chapitre 2,  Entrer, modifier et formater
des données du Guide Calc.
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Remarque
Quand les données sont masquées dans les cellules, les cellules vides restent visibles
dans le classeur.

Masquer et protéger des données
Pour masquer des lignes ou des colonnes :

 1) Sélectionnez la ligne ou la colonne que vous voulez masquer.
 2) Allez à Format dans la barre de Menu et cliquez sur Ligne ou Colonne.
 3) Choisissez Masquer dans le menu et la ligne ou la colonne n’est plus visible ni imprimée.

Vous pouvez aussi faire un clic droit sur l’en-tête de la ligne ou de la colonne et cliquer sur Mas-
quer (les lignes ou les colonnes) dans le menu contextuel.

Pour masquer des feuilles :

 1) Sélectionnez les feuilles que vous voulez masquer.
 2) Allez à Feuille > Masquer les feuilles. Les feuilles ne sont plus visibles ni imprimées.

Vous pouvez aussi faire un clic droit sur l’onglet de la feuille et cliquer sur Masquer dans le menu
contextuel.

Pour masquer et protéger les données dans les cellules sélectionnées :

 1) Allez à Outils > Protéger la feuille. La boîte de dialogue Protéger la feuille s’ouvre (Figure
43).

 2) Cochez Protéger cette feuille et le contenu des cellules verrouillées.
 3) Saisissez un mot de passe puis confirmez-le.
 4) Cochez ou décochez les options de sélection des cellules par l’utilisateur.
 5) Cliquez sur OK.

Figure 43 : La boîte de dialogue Protéger la feuille

 6) Sélectionnez les cellules que vous voulez masquer.
 7) Ouvrez la boîte de dialogue Formatage des cellules,

– en allant à Format > Cellules dans la barre de Menu,
– en faisant un clic droit dans la cellule et en choisissant Formater les cellules dans le

menu contextuel,
– en utilisant le raccourci Ctrl+1 du clavier.

 8) Cliquez sur l’onglet Protection des cellules (Figure 44) et choisissez une option masquer
les cellules.
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 9) Cliquez sur OK.

Figure 44 : Page de Protection de cellule dans la boîte de dialogue Formatage 
des cellules

Remarque
Quand les données d’une cellule sont masquées, la cellule vide reste visible dans le
classeur.

Afficher les données
Pour afficher les lignes et colonnes masquées :

 1) Sélectionnez les lignes ou colonnes de chaque côté de celles qui sont masquées.
 2) Allez à Format dans la barre de Menu et sélectionnez Ligne ou Colonne.
 3) Sélectionnez Afficher dans le menu et la ligne ou la colonne sera affichée et pourra être

imprimée.

Vous pouvez aussi faire un clic droit sur l’en-tête de la ligne ou de la colonne et cliquer sur Affi-
cher (les lignes ou les colonnes) dans le menu contextuel.

Pour afficher des feuilles, allez à  Feuille > Afficher les feuilles et choisissez dans la liste les
feuilles que vous voulez de nouveau afficher. Les feuilles redeviendront visibles et seront impri-
mées.

Vous pouvez aussi faire un clic droit sur l’onglet d’une feuille et cliquer sur Afficher dans le menu
contextuel pour afficher la même liste où vous pourrez choisir les feuilles à afficher de nouveau.

Pour afficher les données masquées dans les cellules :

 1) Allez à Outils > Protéger la feuille. La boîte de dialogue Protéger la feuille s’ouvre.
 2) Saisissez un mot de passe pour déverrouiller la feuille.
 3) Cliquez sur OK.
 4) Ouvrez la boîte de dialogue Formatage des cellules,

– en allant à Format > Cellules dans la barre de Menu,
– en faisant un clic droit dans la cellule et en choisissant Formater les cellules dans le

menu contextuel,
– en utilisant le raccourci Ctrl+1 du clavier.

 5) Cliquez sur l’onglet Protection des cellules (Figure 44) et décochez les options de mas-
quage des cellules. 

 6) Cliquez sur OK.
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Trier des enregistrements

Le tri modifie la disposition des cellules dans la feuille. Dans Calc, vous pouvez utiliser simultané-
ment plusieurs critères de tri, qui sont appliqués l’un après l’autre. Les tris sont pratiques quand
vous cherchez un élément particulier, et sont encore plus puissants combinés aux filtres.

De plus, le tri est souvent utile quand vous ajoutez de nouvelles données. Quand une liste est
longue, il est habituellement plus facile d’ajouter des données en bas de la feuille, plutôt que d’in-
sérer des lignes à leur bonne place. Après avoir ajouté des données, vous pouvez les trier pour
mettre à jour la feuille.

Si les données sont disposées en colonne et comportent un en-tête au format texte,
vous pouvez utiliser le tri rapide. Pour ceci, mettez en surbrillance les cellules à trier,
puis cliquez sur les boutons de barre d’outils Tri croissant ou Tri décroissant.

Pour trier les cellules de votre classeur :

 1) Sélectionnez les cellules à trier.
 2) Allez à  Données > Trier dans la barre de Menu pour ouvrir  la boîte de dialogue  Trier

(Figure 45).

Figure 45 : La boîte de dialogue Critères de tri

 3) Sélectionnez les critères de tri dans les listes déroulantes. Celles-ci sont remplies à partir
des cellules sélectionnées.

 4) Cochez soit un tri ascendant (A-Z, 1-9) soit un tri descendant (Z-A, 9-1).
 5) Cliquez sur OK pour que le tri soit effectué sur la feuille de calcul.

Pour plus d’informations sur les options de tri, voir le chapitre 2,  Entrer, modifier et formater des
données du Guide Calc.
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Utiliser les formules et les fonctions

Vous allez sans doute avoir besoin de plus que du texte et des nombres dans votre feuille de cal-
cul. Souvent le contenu d’une cellule dépend du contenu d’autres cellules. Calc permet de faire
des calculs, des plus simples aux plus complexes en utilisant des formules. Les formules sont des
équations qui utilisent des nombres et des variables pour produire un résultat. Les variables sont
placées dans des cellules qui contiennent les données nécessaires aux équations.

Pour entrer une formule commencer par saisir le symbole égal (=). Par exemple pour calculer en
A3 la différence entre A1 et A2 :

• Sélectionnez A3.

• Saisissez le symbole = ou cliquez sur le bouton Fonction de la barre de formule .
• Saisissez A1-A2 (en minuscules ou majuscules) ou utilisez la souris :

– cliquez dans la cellule A1 (la référence apparaît dans la formule) ;
– saisissez le symbole – pour calculer une différence ;
– cliquez dans la cellule A2 (la référence apparaît dans la formule).

• Validez par la touche Entrée.

La formule finale doit être :

=A1-A2
La cellule A3 affiche le résultat et la barre de formule affiche la formule comme sur la Figure 46.

Opérateurs principaux Symboles

Addition +

Soustraction -

Multiplication *

Division /

Élévation à la puissance ^ (touche Alt Gr+9)

Figure 46 : Résultat de la saisie de la formule

Outre les opérateurs listés ci-dessus, Calc dispose de fonctions. Une fonction est un calcul prédé-
fini saisi dans une cellule pour vous aider à analyser ou manipuler des données. La seule chose
que vous avez à faire est d’ajouter des arguments et le calcul est automatiquement fait pour vous.
Les fonctions vous aident à créer les formules nécessaires à l’obtention des résultats que vous
recherchez.

Par exemple, vous désirez faire la somme des cellules A1 à E1, avec l'opérateur + vous devez sai-
sir une formule du type :

=A1+B1+C1+D1+E1
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Plus le nombre de cellules à additionner sera grand, plus longue et fastidieuse à écrire sera la for-
mule. LibreOffice permet de simplifier l'opération en utilisant la fonction SOMME qui demande uni-
quement l'adresse d’une plage de cellules et non la liste de toutes les cellules. Par exemple :

=SOMME(A1:E1)
Référez-vous au chapitre 7, Formules et fonctions, du Guide Calc pour plus d’informations.

Analyser les données

Calc offre plusieurs outils pour vous aider à analyser les informations contenues dans les feuilles
de calcul, allant des fonctions pour copier et réutiliser les données, à celles permettant de créer
automatiquement des sous-totaux ou encore à faire varier l’information pour vous aider à trouver
les réponses que vous cherchez. Ces outils sont répartis entre le menu Outils et le menu Don-
nées.

L’un des outils les plus utiles est la Table de pilote. C’est un outil pour combiner, comparer et ana-
lyser d’importantes quantités de données facilement. En utilisant la table de pilote, vous pouvez
afficher différents sommaires de source de données, afficher les détails de zone d’intérêts et créer
des rapports, et ce que vous soyez un utilisateur débutant, intermédiaire ou confirmé. Référez-
vous au chapitre 8, Utiliser la table de pilote, du Guide Calc pour plus d’informations.

Calc propose aussi de nombreux outils d’analyse statistique des données qui vous permettent
d’obtenir des informations numériques importantes sur les données provenant de mesures phy-
siques, de sondages ou même de transactions commerciales telles que des ventes, des cotations
boursières, etc. Ces analyses de données statistiques sont accessibles par le menu Données >
Statistiques.

Un autre outil d’analyse de Calc est la possibilité de créer des diagrammes pour visualiser les don-
nées. Les possibilités offertes sont très riches. Référez-vous au chapitre 3, Créer des diagrammes
et des graphiques, du Guide Calc pour plus d’informations.

Impression

L’impression à partir de Calc est pratiquement la même que l’impression à partir des autres com-
posants de LibreOffice (voir le chapitre 10, Impression, exportation, mailing, de ce guide) mais cer-
tains détails sont différents surtout en ce qui concerne la préparation à l’impression.

Utiliser les zones d’impression
Les zones d’impression ont plusieurs utilisations, elles permettent de n’imprimer qu’une partie spé-
cifique des données ou de lignes ou colonnes sélectionnées sur chaque page. Pour plus d’infor-
mations sur les zones d’impression, voir le chapitre 6,  Impression, exportation, mailing du Guide
Calc.

Définir une zone d’impression
Pour définir une nouvelle zone d’impression ou modifier une zone d’impression existante :

 1) Sélectionnez la plage de cellules qui compose la zone d’impression.
 2) Choisissez Format > Zones d’impression > Définir. Les lignes de délimitation des pages

s’affichent à l’écran.
 3) Vous pouvez vérifier la zone d’impression en utilisant Fichier > Aperçu ou en cliquant sur

l’icône  Aperçu  LibreOffice n’affichera que les cellules à l’intérieur de la zone d’im-

pression.
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Conseil
Le mode  Affichage > Aperçu des sauts de page permet également de facilement
repérer la zone d’impression sans passer par l’aperçu avant impression. 

Ajouter une plage à la zone d’impression
Après avoir défini une zone d’impression, vous pouvez lui ajouter des cellules supplémentaires.
Ceci permet d’imprimer plusieurs zones séparées dans la même feuille, sans avoir à imprimer la
feuille en entier. 

Après avoir défini une zone d’impression :

1) Sélectionnez la plage de cellules à ajouter à la zone d’impression.
2) Choisissez  Format > Zones d’impression > Ajouter. Les cellules supplémentaires sont

alors ajoutées à la zone d’impression.
3) Vous pouvez vérifier la zone d’impression en utilisant  Fichier > Aperçu. Ou cliquer sur

l’icône  Aperçu  LibreOffice n’affichera que les cellules à l’intérieur de la zone d’im-

pression.

Les lignes de délimitation des pages ne s’affichent plus à l’écran.

Remarque
La zone d’impression supplémentaire sera imprimée sur une page séparée, même si
les deux zones sont sur la même feuille.

Supprimer une zone d’impression
Il peut devenir nécessaire de supprimer une zone d’impression définie, s’il faut imprimer la feuille
entière par exemple.

Choisissez  Format > Zones d’impression > Effacer. Ceci va supprimer  toutes les zones d’im-
pression définies dans la feuille. Une fois la zone d’impression supprimée, les lignes de délimita-
tion de page par défaut s’afficheront de nouveau à l’écran.

Éditer une zone d’impression
À tout moment vous pouvez éditer directement la zone d’impression par exemple pour supprimer
ou redimensionner une partie de la zone. Choisissez Format > Zones d’impression > Éditer pour
ouvrir la boîte de dialogue Éditer les zones d’impression où vous pouvez définir celles-ci

Options d’impression
Pour sélectionner l’ordre des pages, les détails et l’échelle :

 1) Choisissez Format > Page à partir du menu principal
 2) Dans la boîte de dialogue Style de page (Figure 47), sélectionnez l’onglet Feuille.
 3) Faites votre sélection et cliquez ensuite sur OK.

Pour plus d’informations sur les options d’impression, voir le chapitre 6,  Impression, exportation,
mailing du Guide Calc. 
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Figure 47 : Onglet Feuille de la boîte de dialogue Style de page

Imprimer des lignes ou colonnes sur chaque page
Si une feuille s’imprime sur plusieurs pages, vous pouvez paramétrer le fait que certaines lignes ou
colonnes se répètent sur chaque page imprimée.

Par exemple, si les deux premières lignes, ainsi que la colonne A, doivent être imprimées sur
toutes les pages, effectuez les opérations suivantes :

1) Choisissez Format > Zones d’impression > Éditer. Dans la boîte de dialogue Éditer les
zones d’impression (Figure 48) saisissez les lignes dans la boîte de saisie de texte sous
Lignes à répéter. Par exemple, pour répéter les lignes 1 et 2, tapez $1:$2. Cela va modi-
fier Lignes à répéter de – aucun – à – défini par l’utilisateur -.

2) Pour répéter des colonnes, saisissez-les dans la boîte de saisie de texte sous Colonnes à
répéter. Par exemple, pour répéter la colonne A, tapez $A. Cela va modifier  Colonnes à
répéter de – aucun – à – défini par l’utilisateur -.

3) Cliquez sur OK.

Remarque
Vous pouvez également sélectionner les lignes ou colonnes à répéter avec la souris.
Pour ceci, positionnez le curseur dans la zone de saisie de texte correspondante, puis
sélectionnez dans la feuille la plage de cellules désirée. Il  n’est  pas nécessaire de
sélectionner des lignes ou colonnes entières : une cellule de chaque ligne ou colonne
suffit.

Pour  plus  d’information sur  l’édition  des plages à  imprimer,  voyez le  Guide Calc,  Chapitre 6,
Impression, exportation, mailing.
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Figure 48 : Définir des lignes à répéter

Sauts de page
Si la définition de zones d’impression peut être un puissant outil, il est parfois nécessaire d’ajuster
manuellement l’impression dans Calc. Pour ceci, vous pouvez utiliser un saut de page manuel. Un
saut de page manuel vous aide à vous assurer que vos données vont s’imprimer correctement.
Vous pouvez insérer un saut de page horizontal au-dessus de la cellule active, ou un saut de page
vertical à gauche de celle-ci.

Pour plus d’informations sur les sauts de page manuels, voyez le chapitre 6, Impression, exporta-
tion, mailing du Guide Calc.

Insérer un saut de page
Pour insérer un saut de page :

 1) Activez la cellule où le saut de page va commencer.
 2) Allez à Feuille > Insérer un Saut de page dans la barre de Menu.
 3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors paramétré.

Saut de ligne
Saut de ligne va créer un saut de page au-dessus de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les lignes 14 et 15.

Saut de colonne
Saut de colonne va créer un saut de page à gauche de la cellule sélectionnée. Par exemple, si la
cellule active est H15, le saut de page est alors placé entre les colonnes G et H.

Conseil
Pour voir plus facilement les sauts de page à l’écran, vous pouvez changer leur cou-
leur. Choisissez  Outils > Options > LibreOffice > Couleurs de l’interface et faites
défiler la liste jusqu’à la section Classeur.

Supprimer un saut de page
Pour supprimer un saut de page :

1) Activez la cellule près du saut de page à supprimer.
2) Allez à Feuille > Supprimer le saut de page dans la barre de Menu.
3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.
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Le saut de page est alors supprimé.

Remarque
Plusieurs sauts de ligne et de colonne manuels peuvent exister dans la même feuille.
Si vous voulez les supprimer, vous devez supprimer chaque saut individuellement (voir
l’astuce suivante). Cela peut parfois être difficile, car bien qu’il puisse y avoir un saut
de colonne paramétré dans la feuille, quand vous allez à Feuille > Supprimer le saut
de page, le choix Saut de colonne peut être indisponible (grisé).

Remarque
Pour supprimer le saut de page, vous devez être dans la cellule à côté de celui-ci. Par
exemple, si vous avez défini un saut de colonne alors que vous étiez en H15, vous ne
pouvez pas le supprimer si vous êtes dans la cellule D15. Cependant, vous pouvez le
supprimer depuis n’importe quelle cellule de la colonne H.

Conseil
Vous pouvez également utiliser l’option Supprimer tous les sauts manuels du menu
contextuel si vous avez sélectionné Affichage > Sauts de page.

En-têtes et pieds de page
Les en-têtes et pieds de page sont des éléments de texte prédéfinis qui sont imprimés respective-
ment en haut et en bas d’une page, en dehors de la zone de page. Les en-têtes et les pieds de
page fonctionnent de la même façon. Pour plus d’informations sur la création des en-têtes et des
pieds de page, voyez le chapitre 6, Impression, exportation, mailing du Guide Calc.

Les en-têtes et les pieds de page sont dépendants des styles de page. Vous pouvez définir plus
d’un style de page dans un classeur et attribuer des styles de page différents aux différentes
feuilles.  Pour  plus  d’informations  sur  ces  styles,  voyez le  chapitre 4,  Utiliser  les  styles  et  les
modèles dans Calc, du Guide Calc.

Définir un en-tête ou un pied de page
Pour paramétrer un en-tête ou un pied de page :

 1) Sélectionnez la feuille dont vous voulez paramétrer l’en-tête ou le pied de page. Sélection-
nez Format > Page.

 2) Sélectionnez l’onglet  En-tête (Figure 49) (ou  Pied de page)  dans la boîte de dialogue
Style de page.

 3) Cochez l’option Activer l’en-tête (ou Activer le pied de page).
 4) Cochez  l’option  Contenu identique  gauche/droite si  vous  voulez  que  le  même texte

apparaisse sur les pages de droite comme de gauche.

À ce stade, vous pouvez également paramétrer les marges, l’espacement et la hauteur de l’en-tête
ou du pied de page. Vous pouvez cocher la case Adaptation dynamique de la hauteur pour ajuster
automatiquement la hauteur de l’en-tête ou du pied de page.

Marges
La taille des marges gauche et droite ajuste la distance de l’en-tête ou du pied de page par
rapport aux côtés de la page.

Espacement
L’espacement détermine la distance au-dessus ou en dessous de la feuille à laquelle l’en-
tête ou le pied de page sera imprimé. Ainsi, si l’espacement est de 1 cm, il y aura un espace
de 1 cm entre la feuille et l’en-tête ou le pied de page.
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Hauteur
La hauteur représente la taille de l’en-tête ou du pied de page.

Figure 49 : Boîte de dialogue Style de page – Pied de page

Pour modifier l’apparence de l’en-tête ou du pied de page, cliquez sur le bouton Plus, ce qui va
ouvrir la boîte de dialogue Bordure / Arrière-plan. À partir de cette boîte de dialogue, vous pouvez
définir l’arrière-plan et la bordure de l’en-tête ou du pied de page. Pour plus d’informations, voir le
chapitre 4 Utiliser les styles et les modèles dans le Guide Calc.

Pour définir le contenu de l’en-tête ou du pied de page (numéro de page, date, etc.), cliquez sur le
bouton Éditer dans la boîte de dialogue de la Figure 49 afin d’afficher la boîte de dialogue En-tête
(ou Pied de page). Pour plus d’informations, voyez le chapitre 6, Impression, exportation, mailing
du Guide Calc.
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